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1 Product overview

This chapter presents an overview of the hardware components of the workstation. It includes these
topics:

Topics

Product features on page 1

Workstation specifications on page 7

Product features
The following sections describe the workstation system board architecture and components, and
includes these topics:

Topics

System board architecture on page 1

Workstation components on page 4

System board architecture
This section describes the workstation system architecture.
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The following figure shows the typical workstation system board block diagram.

Figure 1-1  System board block diagram

NOTE: The x1, x4, x8, and x16 designators describe the number of electrical PCIe lanes routed to an
expansion slot. For example, x16(8) means that the expansion slot is mechanically a x16 length
connector, with eight PCIe lanes connected.

Processor technology
This workstation uses the Intel® X58 Express chipset to support the latest Quad Core Intel® Xeon™
processor W3500 Series, including processors up to 130W. These processors incorporate an integrated
3-channel memory controller, microarchitecture improvements and large L3 cache to provide superior
performance. In addition, the workstation uses Intel QuickPath Interconnect (QPI) to connect the
processor and I/O controller with speeds up to 6.4 GT/s.

Memory technology
The workstation dual in-line memory modules (DIMMs) are based on DDR3 1333MHz technology, and
are error checking and correcting (ECC)-protected. Three direct attach memory channels enable low
latency accesses and fast data transfer for improved performance. System memory sizes up to 16GB
(using 4GB DIMMs) are supported.

NOTE: DIMMs should be distributed across all three memory channels for optimal performance.

Graphics
The workstation supports PCIe Gen2 (PCIe2) bus speeds and can support dual PCIe Gen2 graphics
cards in PCIe2 x16 slots. It supports graphics cards up to 150W in the primary graphics slot. If the
primary graphics card consumes less than 150W, a second graphics card may be supported in the
second PCIe2 x16 slot, subject to the overall 150W power system limitations.
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Expansion card slots
The workstation implements one Intel X58 I/O chip to provide a total of six high-performance graphics
and I/O slots. In addition to the two full x16 PCIe Gen2 slots, two additional PCIe x8 (4) slots (x8
mechanically, x4 electrically) provide extra I/O bandwidth for high speed I/O cards. Open ended PCIe
x8 connectors allow the user to install x16 physical size cards in the x8 (4) slots. Serial Attached SCSI
(SAS) drives are supported via a plug-in card.

Additional features
Redundant array of independent disks (RAID) configurations for SATA support modes 0, 1, 5 and 10.
eSATA (3.0 Gbps) is supported using an optional adapter. The workstation provides 8 external and 4
internal USB 2.0 ports. The 475W power supply is 85% efficient and enables Energy Star Version 5.0
system configurations. HP WattSaver technology enables support of the European Union EuP power
limit of 1W in off mode. HP Quiet Fan Technology enables quiet system operation.
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Workstation components
This section describes workstation components, including front and rear panel components.

For complete and current information on supported accessories and components for the workstation,
see http://partsurfer.hp.com.

Chassis components
The following image shows the components of a typical workstation configuration. Drive configurations
can vary.

Figure 1-2  Workstation components

Table 1-1  Workstation component descriptions

Item Description Item Description

1 Power supply 8 Memory module (DIMM)

2 Side access panel 9 System board

3 Rear system fan 10 PCIe card

4 Hard disk drive 11 PCI card

5 Optical drive 12 Speaker

6 Processor heatsink 13 Front bezel

7 Processor (CPU) 14 Chassis
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Front panel components
The following figure shows the front panel of a typical workstation configuration.

Figure 1-3  Front panel

Table 1-2  Front panel connectors

Item Symbol Description Item Symbol Description

1  Optical drive manual eject 6 Headphone connector

2  Optical drive eject button 7 Microphone connector

3 Power button 8 1394a connector (optional and plugged
unless configured)

4 Hard drive activity light 9  Optical drive activity light

5 USB 2.0 ports (2) 10  Optical drive
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Rear panel components
The following figure shows the rear panel of a typical workstation configuration.

Figure 1-4  Rear panel

NOTE: The rear panel connectors are labeled with industry-standard icons and colors to assist in
connecting peripheral devices.

Table 1-3  Rear panel connectors

Item Symbol Description Item Symbol Description

1  Power supply Built-In Self Test (BIST)
LED

8  Padlock loop

2  Universal chassis clamp opening 9  Graphics card connector

3 PS/2 mouse connector (green) 10 Audio line-out connector (green)

4 USB 2.0 ports (4) 11 Microphone connector (pink)

5 RJ-45 network connector 12 USB 2.0 ports (2)

6 Audio line-in connector (blue) 13 PS/2 keyboard connector (purple)

7  Cable lock slot 14  Power cord connector

6 Chapter 1   Product overview ENWW



Workstation specifications
This section provides workstation chassis, power supply, and environmental specifications.

Physical characteristics
The following table lists the workstation physical characteristics.

Weight (Typical configuration) 13.5-19.6 kg (29.8-43.2 lb.)

Chassis Dimensions Height: 45.0 cm (17.7 in.)

Width: 17.0 cm (6.7 in.)

Depth: 44.5 cm (17.5 in.)

Power supply description
The workstation includes a 475-W 85% efficient power supply to provide power for the workstation. The
power supply is compatible with ENERGY STAR requirements.

Power supply voltages
Table 1-4  Power supply source voltages

Source voltage Description

+3.3V PCI, PCIe, audio, clocks, chipset, super I/O, BIOS ROM, and onboard logic

+5.1V Storage (hard disk drive, optical disk drive, diskette drive), PCI, PCIe,
chipset, audio, keyboard/mouse, and USB

+12 V-CPU Input to onboard regulator that supplies power to CPU and CPU fan

+12 V-B PCI, PCIe, and system fans

+12 V-D Storage (hard disk drive, optical disk drive, diskette drive), graphics adapter,
and input to onboard regulator that supplies power to memory

V12N PCI and serial ports

+5 V-SB Sleep circuitry
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Power supply currents
Table 1-5  Maximum current per rail

Voltage rail 475W maximum
continuous current

+12 V-CPU 17.5A

+12 V-B 17.5A

+12 V-D 18.0A

V12N 0.30A

+5 V-SB 2.25A

3.3V 15.0A

5.1V 21.0A

CAUTION: Do not exceed 475 watts of total continuous output power.

Maximum combined power on 3.3V and 5.1V is 110W.

Maximum combined current on +12V(CPU,B,D) is 38A.
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Power supply specifications
Table 1-6  Power supply specifications

Item Description

Power supply 475W Wide Ranging, Active PFC and
85% efficient

Operating voltage range 90 – 269 VAC

Rated voltage range 100–240 VAC 118 VAC

Rated line frequency 50–60 Hz 400 Hz

Operating line frequency range 47–66 Hz 393–407 Hz

Rated input current 10A @ 100-127 VAC

6A @ 200–240 VAC

10A @ 118 VAC

Heat dissipation

(Configuration and software dependent)

Typical 954 Btu/hr = (240.3 kg-cal/hr)

Maximum 1977 Btu/hr = (498.2 kg-cal/hr)

Power supply fan One fan, 92mm x 25mm, variable speed

FEMP Standby Power compliant @115V
(<2W in S5 – Power Off)

Yes

EuP Compliant @230V (<1w in S5 – Power
Off)

Yes

Built-in Self Test LED Yes

Surge tolerant full ranging power supply
(withstands power surges up to 2000V)

Yes

Power Consumption in sleep mode (as
defined by ENERGY STAR) - Suspend to
RAM (S3) (Instantly Available PC)

<6 watts

Power consumption and heat dissipation
Power consumption and heat dissipation specifications are available for multiple configurations. To
review available specifications, see http://www.hp.com/go/quickspecs.

To reach zero power consumption, unplug the workstation from the power outlet or use a power strip
with an on/off switch. For additional information about power-saving features, see the operating system
installation instructions.

This product is in compliance with U.S. Executive Order 13221.
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System fans 
This workstation includes:

● One rear system fan

● One CPU heatsink fan

● One power supply fan

In addition, an optional front system fan is available for special environments, and some graphics cards
include onboard fans.

Resetting the power supply
If an overload triggers the power supply overload protection, power is immediately disconnected.

To reset the power supply:

1. Disconnect the power cord from the workstation.

2. Determine what caused the overload and fix the problem. For troubleshooting information, see
Diagnostics and troubleshooting on page 108.

3. Reconnect the power cord and restart the workstation.

When you power off the workstation through the operating system, power consumption falls below what
is considered low power consumption but does not reach zero. This low power consumption feature
extends the life of the power supply.
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Environmental specifications
The following table lists the environmental specifications of HP Workstations.

Table 1-7  HP Workstation environmental specifications

Temperature

Operating: 5 to 35°C (40 to 95°F)

Non-operating: -40 to 60°C (-40 to 140°F)

NOTE: Derate by one degree C (1.8 degrees F) for every 305m (1,000 ft.) altitude over 1,524m
(5,000 ft.).

Humidity
Operating: 8 to 85% Relative Humidity (RH), non-condensing

Non-operating: 8 to 90% Relative Humidity, non-condensing

Altitude
Operating: 0 to 3,048m (10,000 ft.)

Non-operating: 0 to 9,144m (30,000 ft.)

Shock

Operating: ½-sine: 40g, 2-3ms

Non-operating:

● ½-sine: 160 cm/s, 2-3ms (~100g)

● square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive shock events.

Vibration

Operating Random: 0.5g (rms), 5-300 Hz

Non-Operating: random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.
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ENERGY STAR Qualification
HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S.
Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA
ENERGY STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, Hewlett-
Packard Company has determined the products marked with the ENERGY STAR logo are ENERGY
STAR qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo
appears on all ENERGY STAR qualified computers.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way
products achieve this energy efficiency is by reducing power consumption when not being used through
the Microsoft Windows Power Management feature.

The Power Management feature enables the workstation to enter a low-power (or “sleep”) mode after
a period of inactivity. When used with an external monitor that is ENERGY STAR qualified, this feature
also supports the similar power management features of the external monitor.

To take advantage of this energy savings:

● The Power Management feature has been preset to suspend the workstation to a sleep state after
30 minutes of inactivity.

● The Power Management feature has been preset to suspend the monitor to a sleep state after 15
minutes of inactivity.

Both the computer and monitor can be woken from sleep mode through user interaction with any of the
computer input devices (mouse, keyboard, and so on). when configured with Wake On LAN (WOL)
enabled, the workstation can also be woken by a network signal.

See the EPA ENERGY STAR Power Management Web site for more information about the energy and
financial savings potential of the Power Management Feature: http://www.energystar.gov/
powermanagement.

See the EPA ENERGY STAR Web site for more information about the ENERGY STAR program and
its environmental benefits: http://www.energystar.gov.

CAUTION:  Using the Energy Save Monitor feature with monitors that are not ENERGY STAR qualified
can cause video distortion when an Energy Save timeout occurs.

NOTE:  ENERGY STAR is not supported on Linux workstations.

If it is necessary to restore the operating system, you must also reset the ENERGY STAR settings (if
applicable) after the restore.

To verify the factory default power settings for your workstation, select Start>Control Panel, and then
double-click Power Options.
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EUP compliance mode
This workstation provides EUP compliance mode capability.

When enabled, this feature enables the workstation to shut down to the lowest possible power state by
removing all power to the system board.

When disabled, the workstation powers down conventionally.

When the workstation is shut down in EUP compliance mode, it must be powered up with the workstation
power button.

Enabling EUP compliance mode
To enable EUP compliance mode:

1. Press F10 during start up.

2. Using the arrow keys, select the Power>Hardware Power Management>EuP Compliance
Mode, and then select Enable.

3. Press F10 to accept the change.

4. Select File>Save Change and Exit, and then press F10 to accept the change.

Disabling EUP compliance mode
To disable the EUP compliance mode:

1. Press F10 during start up.

2. Select Power>Hardware Power Management>EuP Compliance Mode, and then select
Disable.

3. Press F10 to accept the change.

4. Select File>Save Change and Exit, and then press F10 to accept the change.

Accessibility
HP is committed to developing products, services, and information that is easier to access for all
customers, including customers with disabilities and age-related limitations. HP products with Windows
Vista® Business and Microsoft® Windows® XP Professional preinstalled are designed for accessibility,
and these products are tested with industry-leading Assistive Technology products. For more
information see http://www.hp.com/accessibility.

Hyper-threading
This HP workstation supports Hyper-threading.

Hyper-Threading Technology (HTT), is an Intel-proprietary technology used to provide process
parallelization . The technology improves processor performance under certain workloads by providing
useful work for execution units that would otherwise be idle. A processor with Hyper-Threading enabled
is treated by the operating system as two processors instead of one. Hyper-threading relies on support
in the operating system as well as the CPU.

To implement hyper-threading, see The Computer Setup (F10) Utility on page 29.

Intel Turbo Boost Technology
The HP Z Workstation series supports Intel® Turbo Boost Technology.
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This feature enables the CPU to run at a higher than normal rate. When all CPU cores are not necessary
for the workload, inactive cores are turned off and power is diverted to the active cores to increase their
performance.

Turbo Boost is enabled and disabled in workstation BIOS. For instructions on setting BIOS features,
see The Computer Setup (F10) Utility on page 29.

HP Cool Tools
An HP workstation with Windows XP includes additional software that is not installed when you first start
the workstation. To access or learn more about these additional preinstalled tools on the workstation
that can enhance the workstation experience:

1. Open the HP Cool Tools folder by selecting Start>All Programs>HP Cool Tools.

2. Select the HP Cool Tools icon on the desktop.

3. To learn more about these applications, select HP Cool Tools—Learn More.

4. To install or launch the applications, select the appropriate application.

NOTE: A preinstalled Windows Vista Business operating system does not contain a Cool Tools icon,
shortcut or folder but several of the tool programs are included, such as Performance Tuning Framework.
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Ensuring proper ventilation
Proper ventilation for the system is important for workstation operation. Follow these guidelines to
ensure adequate ventilation:

● Operate the workstation on a sturdy, level surface.

● Place the workstation in an area with adequate ventilation. Provide at least 6 inches of clearance
at the front and back of the workstation as shown in the following figure.

Your workstation might look different than the one shown.

Figure 1-5  Proper workstation ventilation

● Ensure that the ambient air temperature surrounding the workstation falls within the published limit.

NOTE: The ambient upper limit of 35°C is only good up to 5000 feet elevation. There is a 1°C
per 1000 feet derating above 5000 feet. So at 10,000 feet the upper ambient air temperature limit
is 30°C.

● For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient
temperature within the cabinet does not exceed published limits.

● Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air intakes
as shown in the following figure.

Figure 1-6  Proper workstation placement

ENWW Workstation specifications 15



2 Setting up the operating system

This chapter provides setup and update information for the workstation operating system. It includes
these topics:

Topics

Setting up the Microsoft operating system on page 17

Setting up Red Hat Enterprise Linux on page 18

Setting up Novell SLED on page 19

Updating the workstation on page 19

This chapter also includes information on how to determine that you have the latest BIOS, drivers, and
software updates installed on the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.
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Setting up the Microsoft operating system
NOTE: If you ordered a downgrade from Windows Vista to Windows XP Professional operating
system, your system will be preinstalled with Windows XP Professional operating system. With this
configuration, you will receive recovery media for Windows Vista operating system only. In case you
need to restore or recover the Windows XP Professional operating system in the future, it is important
that you create recovery media disks for Windows XP Professional operating system after first boot.

When you first apply power to the workstation, the operating system is installed. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the installation.

CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the software.

For complete operating system installation and configuration instructions, see the operating system
documentation that was provided with the workstation. Additional information is available in the online
help tool after you successfully install the operating system.

Installing or upgrading device drivers
To install hardware devices after the operating system is installed, you must install the appropriate
device drivers before you install the devices. Follow the installation instructions that came with the
device. In addition, for optimum performance, your operating system must have the most recent updates,
patches, and software fixes. For additional driver and software update information, refer to Upgrading
device drivers on page 21.

Transferring files and settings to your Windows workstation
The Microsoft Windows operating system offers data migration tools that helps you choose and transfer
files and data from a Windows computer to your Windows Vista or Windows XP Professional operating
system workstation.

For instructions on how to use these tools, see the documents at http://www.microsoft.com.
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Setting up Red Hat Enterprise Linux
HP offers an HP Installer Kit for Linux (HPIKL) to supplement Red Hat box sets and help HP Linux
customers customize their system image. The HPIKL contains the HP driver CD and device drivers to
successfully setup up the Red Hat Enterprise Linux (RHEL) operating system, The HP Installer Kit for
Linux CDs are currently available for download at http://www.hp.com/support/workstation_swdrivers.

Installing with the HP driver CD
To install the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the HP Workstations for
Linux manual at http://www.hp.com/support/workstation_manuals.
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Installing and customizing Red Hat-enabled workstations
Linux-enabled workstations require the HP Installer Kit and the purchase of a Red Hat Enterprise Linux
box set. The Installer kit includes the HP CDs necessary to complete the installation of all versions of
the Red Hat Enterprise Linux box set that have been qualified to work on an HP workstation.

To use the drivers in the HP Installer kit for Linux other than RHEL, you must manually extract the drivers
from the HP Driver CD and install them. HP does not test the installation of these drivers on other Linux
distributions nor does HP support this operation.

Verifying hardware compatibility
To see which Linux versions have been qualified to work on HP Workstations visit http://www.hp.com/
support/linux_hardware_matrix.

Setting up Novell SLED
To set up the SUSE Linux Enterprise Desktop (SLED) on systems preloaded with the operating system:

1. Boot the workstation.

2. Start the Installation Settings and enter the password, network, graphics, time, keyboard settings,
and Novell Customer Center Configuration for the workstation.

NOTE: During Installation Settings after the first time after booting the system the Novell
subscription can be activated from the Novell Customer Center Configuration screen. Visit the full
Novell Customer Center documentation at http://www.novell.com/documentation/ncc/.

Updating the workstation
HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and
software updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:

● Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 19 for
instructions.

● Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 21 for instructions.

● Become familiar with your available HP resources.

● Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.
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Determining current BIOS
To determine the current BIOS of the workstation during system power up:

1. Wait for F10=setup to appear on the lower right corner of the screen.

2. Press F10 to enter the F10 Setup utility.

The F10 Setup utility displays the workstation BIOS version under File > System Information.

3. Note the workstation BIOS version so that you can compare it with the BIOS versions that appear
on the HP website.
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Upgrading BIOS
To find and download the latest available BIOS, which includes the latest enhancements:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the Web site is the same as the version on your system, no further action is required.

5. If the BIOS on the Web site is a version later than the one on your system, download the appropriate
version for the workstation. Follow the instructions in the release notes to complete the installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP Web site
to download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP Web site first to see if
your device and its drivers have been tested for HP workstation compatibility. If no driver is available,
visit the device manufacturer's Web site to download the latest drivers.

To upgrade device drivers:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the Web site of the manufacturer of the peripheral device.
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3 Restoring the operating system

This chapter describes how to restore the Windows or Linux operating system. It includes these topics:

Topics

Restore methods on page 22

Ordering backup software on page 23

Restoring Windows Vista on page 23

Restoring Windows XP Professional on page 24

Restoring Novell SLED on page 26

Installing with the HP driver CD on page 18

Restore methods
The Windows Business Vista operating system can be reinstalled using the HP RestorePlus! process.
The Windows XP Professional operating system can be reinstalled using the RestorePlus! process or
the HP Backup and Recovery Manager.

● RestorePlus!

The RestorePlus! process reinstalls the Windows operating system and device drivers (for devices
included with the system) to a near-factory state. The process does not back up or recover data
on the hard drive. Some application software might not be restored using this process and must
be installed from the appropriate application CD.

● HP Backup and Recovery Manager (HPBR) Recovery Point

The HP Backup and Recovery Manager application can be used to capture and restore the contents
of the system partition. It captures a snapshot of the system partition and stores it in a Recovery
Point. Everything on the system partition at the time the recovery point was made is saved.

NOTE: HP Backup and Restore is only supported on the HP xw6600 and xw8600 Workstations.

The Recovery Point is saved to the hard drive and can be burned to media for safekeeping.

CAUTION: These methods restore the operating system, but not data. Data must be backed up
regularly to avoid loss.
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Ordering backup software
If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from the HP
support center. To obtain the support center telephone number for your region visit http://www.hp.com/
support/contactHP.

Restoring Windows Vista
This section describes how to restore Windows Vista.

Ordering the RestorePlus! media
If you ordered restore media with your workstation, the media is included with your workstation
components.

If you did not order restore media, call HP Support and request a RestorePlus! media kit. For worldwide
technical support phone numbers, visit http://www.hp.com/support.

Restoring the operating system
NOTE: Windows Vista provides a backup and restore application as well. To learn more about this
application, visit the Microsoft Web site.

CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive,
including all partitions.

To restore Windows Vista:

1. Boot from the RestorePlus! DVD to start the RestorePlus! process. You must start from the
RestorePlus! DVD to install device drivers and settings.

2. Follow the prompts to restore your operating system.

Some application software might not be restored using this process. If software is not restored, install
it from the appropriate application DVD.
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Restoring Windows XP Professional
This section describes how to restore the Windows XP Professional operating system.

NOTE: The workstation must have a CD or DVD writer installed to create the media set.

Creating RestorePlus! media
The RestorePlus! kit can be created using the files contained on the hard drive. To create the restore
media:

1. Boot the workstation.

2. During boot up, an HP Backup and Recovery Manager screen is displayed prompting you to create
Recovery CDs or DVDs. Select Now.

3. An Initial Recovery Point (IRP) of the system is captured. This is a snapshot of the system hard
drive. The capture can take more than 10 minutes.

4. After the IRP is created, you can create a set of backup CDs or DVDs.

To create a RestorePlus! media set including the Windows XP operating system CD, select
RestorePlus! > Microsoft Windows XP operating system > Supplemental media.

NOTE: Depending on the options, there might be additional DVDs you can create.

5. Follow the prompts to create RestorePlus!, operating system, and HPBR media.

If you are unable to create CD/DVDs on your workstation, call HP Support and request a RestorePlus!
media kit. For worldwide technical support phone numbers, visit http://www.hp.com/support.
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Creating HP Backup and Recovery (HPBR) media
NOTE: HPBR functionality is used with Windows XP only. For details, refer to the SoftThinks guide
on the Documentation and Diagnostics CD included with the workstation.

The Initial Recovery Point can be burned to optical media and used to recover a system. This section
describes making the media.

NOTE: The workstation must have a CD or DVD writer to create the media set.

To create HPBR recovery media:

1. The Initial Recovery Point was captured when the RestorePlus! media set was created previously.

If the IRP was not created, start the HP Backup and Recovery Manager and create recovery points
using the Expert mode. Follow the HPBR online documentation for instructions.

2. Burn the IRP to media from HPBR.

Select HPBR Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Select Next at the first screen.

Select Create recovery CDs or DVDs to recover the system, and then select Next.

4. Choose Next to display a list of available CD image and the recovery points.

5. Check the box next to Initial Recovery Point, and then select Next.

6. Follow the instructions to create the media.
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Restoring the operating system
CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive,
including all partitions. If you run RestorePlus! from the recovery partition, only the root (C:) partition is
affected.

Using RestorePlus!
To restore with RestorePlus!:

1. Boot the workstation from the RestorePlus! DVD. You must start from the RestorePlus! DVD for
device drivers and settings to be installed.

2. Follow the prompts to restore the operating system.

Some application software might not be restored using this process. If software is not restored, install
it from the appropriate application DVD.

Using HPBR
To restore with the HPBR Initial Recovery Point media:

1. Boot the workstation from the Initial Recovery Point media.

2. Follow the prompts to restore the system to the state when the IRP was created.

Using the recovery partition
A system that shipped with Windows XP includes a recovery partition. You can boot the system from
that recovery partition.

From the recovery partition you can perform a system restore using the HPBR Initial Recovery Point, if
it was created. If it was not, you can use a RestorePlus! install.

To restore using the recovery partition:

1. Boot the workstation.

2. When prompted on the boot screen to enter the Recovery Manager, press F11.

TIP: The opportunity to press F11 during the boot process is small. It comes about the time the
F10 prompt appears.

NOTE: To ensure that the recovery processes reinstall on the correct hard drive, do not
disconnect the target drive during the recovery process.

3. Follow the prompts to restore the system to factory-like condition.

Restoring Novell SLED
The SLED restore media is required to restore the Linux operating system.

Creating restore media
THE SUSE Linux Enterprise Desktop preload includes a SUSE ISO icon on the desktop. You can click
this icon to go to the /iso directory. The /iso directory contains all iso images used to preload your
workstation. To recover or restore the original image, follow the instructions in the readme file in the /
iso directory to copy the ISO image file onto CDs.

26 Chapter 3   Restoring the operating system ENWW



NOTE: Make copies of the ISO recovery images on CD as backup files in case your workstation
experiences a hard drive failure.
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4 System management

This section describes the tools and utilities that provide system management for the workstation. It
includes these topics:

Topics

BIOS ROM on page 29

The Computer Setup (F10) Utility on page 29

Workstation management on page 39
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BIOS ROM
The BIOS ROM is a collection of machine language applications stored as firmware in ROM. It includes
functions such as POST, PCI device initialization, Plug and Play support, power management, and the
Computer Setup (F10) Utility. The BIOS ROM is a 1-MB Serial Peripheral Interface (SPI) port.

See http://www.hp.com/go/quickspecs to review the latest BIOS ROM specifications.

The Computer Setup (F10) Utility
This section contains these topics:

Topics

Computer Setup (F10) functionality
on page 29

Accessing the Computer Setup (F10) Utility
on page 31

The Computer Setup (F10) Utility menu
on page 32

Computer Setup (F10) functionality
The Computer Setup (F10) Utility enables you to:

● Change factory default settings and set or change the workstation configuration, which might be
necessary when you add or remove hardware.

● Determine if all devices installed on the workstation are recognized by the system and functioning.

● Determine information about the operating environment of the workstation.

● Solve system configuration errors that are detected but not fixed during the Power-On Self-Test
(POST).

● Establish and manage passwords and other security features.

● Establish and manage energy-saving time-outs (not supported on Linux platforms).

● Modify or restore factory default settings.

● Set the workstation date and time.

● Set, view, change, or verify the workstation configuration, including settings for CPU, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of installed mass storage devices such as SATA, SAS, diskette drives, optical
disk drives, network drives, LS-120 drives and USB boot devices.

● Configure the boot priority of SATA and SAS hard-drive controllers.

● Enable or disable Network Server Mode, which enables the workstation to start the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the workstation, the keyboard and mouse remain locked until the power-on
password is entered.

● Enable or disable POST Messages to change the display status of POST messages. POST
Messages disabled suppresses most POST messages, such as memory count, product name, and
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other nonerror text messages. If a POST error occurs, the error is displayed regardless of the mode
selected. To manually switch to POST Messages Enabled during POST, press any key except
F1 through F12.

● Specify an Ownership Tag, which appears when the workstation is powered on or restarted.

● Specify the Asset Tag or property identification number assigned by the company to this
workstation.

● Enable power-on password prompts during system restarts (warm-starts) and power on.

● Hide or show the integrated I/O functionality, including serial, USB, or parallel ports, audio, or
embedded NIC. Hidden devices are inaccessible, which increases system security.

● Enable or disable removable media boot ability.

● Enable or disable removable media write ability (if supported by hardware).

● Replicate the workstation setup by saving system configuration information on CD or diskette and
restoring it on workstations.

● Execute self-tests on specified SATA and SAS hard disk drives (if supported by the drive).
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Accessing the Computer Setup (F10) Utility
To access the Computer Setup (F10) Utility menu:

1. Power on or restart the workstation.

2. When the display is active and F10=Setup appears in the lower right corner of the screen,
press F10.

If you do not press F10 at the appropriate time, try again. Turn the workstation off, then on, and
press F10 again to access the utility. You can also press the Ctrl + Alt + Delete keys before starting
if you miss the opportunity to press F10.

3. Select the language from the list and press the Enter key.

In the Computer Setup (F10) Utility menu, five headings are displayed: File, Storage, Security,
Power, and Advanced.

4. Use the left and right arrow keys to select the appropriate heading, use the up and down arrow
keys to select an option, and then press Enter.

5. Choose from the following:

● To apply and save changes, select File>Save Changes, and then select F10=YES.

● To remove changes you have made, select Ignore Changes and then select F10=YES.

● To reset to factory settings, select  File>Default Setup>Restore Factory Settings as
Default. Press F10 to accept the changes, and then select Apply Defaults and Exit. This
restores the original factory system defaults.

CAUTION: Do not power off the workstation while the ROM is saving the Computer Setup (F10) Utility
changes, because the Complementary Metal-Oxide Semiconductor (CMOS) could become corrupted.
After you exit the F10 Setup screen, you can disconnect power from the workstation.
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The Computer Setup (F10) Utility menu
The following table describes the functions available in the Computer Setup (F10) utility menu.

NOTE: With new BIOS releases, the following content is subject to change, so the menu might be
different than shown.

Table 4-1  Computer Setup (F10) Utility menu descriptions

Heading Option Description

File System
Information

Displays the following system characteristics:

● Product Name

● QPI Link Speed

● Memory Size

● Integrated MAC

● System BIOS

● Boot Block Date

● Chassis serial number

● Asset Tracking Number

● Management Module

● Processor Type

● Processor Speed

● Processor Stepping

● Cache Size

● DIMMs

 About Displays copyright information.

System
Temperatures

Displays system temperatures and fan speeds.

 Set Time and
Date

Enables you to set system time and date.

 Flash System
ROM

Enables you to upgrade the BIOS from a ROM image on diskette, CD, or USB.

 Replicated
Setup

Provides these options:

● Save to Removable Media—Saves the workstation configuration, including CMOS, in the
qsetup.txt file. This file can be saved to a formatted, blank 1.44-MB diskette, or to a USB
device.

● Restore from Removable Media—Restores the workstation configuration from a diskette or
a USB device.

 Default Setup Provides these options:

● Save Current Settings as Default—Saves the current settings as default settings for the next
operation.

● Restore Factory Settings as Default—Restores the factory settings as the default settings for
the next operation.

 Apply Defaults
and Exit

Restores the default settings defined in Default Setup.
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Heading Option Description

 Ignore Changes
and Exit

Exits workstation setup without applying or saving changes.

 Save Changes
and Exit

Saves changes to system configuration and exits the workstation setup.

Storage Device
Configuration

Lists installed non-SCSI storage devices (except SATA devices) and provides options for obtaining
specific information about each device:

● Hard Disk—Provides information about the hard disk drives in the workstation. It is available
in IDE Mode only.

● CD-ROM—Provides information about the optical disk drives in the workstation. (IDE mode
only.)

● Diskette Type (for legacy diskette drives only)—Identifies the highest capacity media type
accepted by the diskette drive. Options are 3.5" (1.44 MB), 5.25" (1.2 MB), and Not Installed.

● Default Values—Resets devices to their default configuration (SATA is the default).

◦ Multisector Transfers—Defines the transfer of data per interrupt. Options are 8, 16, and
Disable (16 is the default).

◦ Transfer Mode—Specifies the active data transfer mode. Options (subject to device
capabilities) are Max UDMA, PIO 0, Max PIO, Enhanced DMA, and Ultra DMA0. (Max
UDMA is the default).

◦ Translation Mode—Enables the BIOS to determine the translation mode used to
configure a formatted SATA or USB mass storage device. This prevents you from
needing to know how the mass storage device was formatted. Options are Automatic,
Bit Shift, LBA Assisted, Use (Cylinders, Heads, Sectors), and Off. Automatic is the
default.

Ordinarily, you should not change the translation mode selected by the BIOS. If the
selected translation mode is not compatible with the translation mode that was active
when the drive was partitioned and formatted, the data on the disk is inaccessible.

 Storage Options Provides these options:

● Removable Media Boot—Enables and disables the ability to start the workstation from
removable media.

● Legacy Diskette Write—Enables and disables the ability to write data to removable media.

● SATA Emulation—Sets the SATA emulation mode with the following options:

◦ RAID + AHCI—both the RAID and AHCI OPROMs execute. This emulation mode is the
default and offers the best performance and most functionality.

◦ IDE —offers standard SATA supports (four ports only).

● SATA PORT 0-n—enables and disables the SATA ports. Offers these configurations:

◦ GEN 2/3.0 Gbps (Internal Only/eSATA Only)

◦ GEN 1/1.5 Gbps (eSATA Only)

 DPS Self-test Select a drive—Enables you to select a drive to test. This option is available in SATA IDE emulation
mode only.

The DPS self-test function directs an IDE hard disk to run an internal self-test and report the results.
If the SATA controller is not in IDE emulation mode, the DPS self-test option is not displayed in the
setup menu.

This selection appears only when at least one drive capable of performing the IDE DPS self-test
is attached to the workstation. By default, the SATA controller is in RAID+AHCI mode, so this option
is not displayed

Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

 Boot Order Enables you to configure the boot, diskette drive, and hard disk drive orders by physically
reordering the menu entries. The following is the default boot order presented in the menu:

● Optical Drive

● Diskette Drive

● USB Device

● Hard Drive

● Embedded Ethernet controller

● Embedded Ethernet controller (ASF) Second embedded LAN. (Not available in some
configurations.)

Press Enter to drag a device to a preferred place. Press F5 to remove the device from consideration
as a bootable device.

MS-DOS drive lettering assignments might not apply after an operating system other than MS-
DOS has started.

Boot devices can be disabled in the boot order process. These order changes are stored in the
physical ROM when the F10 Setup changes are confirmed with File>Save Changes and Exit.

You can temporarily override the boot order. To start one time from a device other than the default
device specified in Boot Order, restart the workstation and press F9 when the F9=Boot Menu
message appears on the screen. After POST completes, a list of bootable devices is displayed.
Use the arrow keys to select the preferred bootable device and press Enter. The workstation then
starts from the selected nondefault device for this one time.

Security Setup Password Enables you to set and enable a setup password for the administrator.

If you create a setup password, you must use it to change workstation setup options, to flash the
ROM, and to make changes to certain Plug and Play settings under Windows.

 Power-On
Password

Enables you to set and enable the power-on password.

 Password
Options

This option becomes available when you create a setup and/or power-on password. It provides
these options:

● Lock Legacy Resources—Prevents the operating system from changing resources to serial,
parallel, or diskette controller.

● Network Server Mode—Enables network server mode.

● Password Prompt on Warm Boot—Enables a password prompt on a warm boot.

● Setup Browse Mode—Enables read-only functionality for password info.

 Smart Cover Enables you to enable and disable the cover removal sensor, or to notify you if the sensor is
activated.

Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

 Device Security Makes the following devices available or hidden to the workstation:

● Serial Port

● Front USB Ports

● Rear USB Ports

● Internal USB Ports

● System Audio

● IEEE 1394 Controller (Not available on some models.)

● Ethernet Controller

● Ethernet Controller (ASF) (Not available on some models.)

● SAS Controller (Not available on some models)

● Legacy Diskette

● Embedded Security Device

● SATA 0-n

For each device, Device Available is the default setting and allows the operating system to access
the device. Device Hidden makes the device unavailable; it is disabled by the BIOS and cannot be
enabled by the operating system.

NOTE: An entry for enabling DriveLock appears in the setup menu if the workstation has a
DriveLock-compatible hard disk drive.

 Embedded
Security Device

This option becomes available if Embedded Device is set to Available.

Embedded Security Device (Hidden or Available) turns the Trusted Platform Mechanism (TPM) on
and off. Device Hidden is the default. If this option is made available, the following options become
available:

● Power-On Authentication Support—Enables and disables an authentication feature that
requires you to enter a TPM user key password to start the workstation. This feature uses the
TPM to generate and store the authentication password.

● Reset Authentication Credential—Resets the authentication functionality and clears
authentication credentials.

To enable the Embedded Security Device and to access any security features associated with the
device, you must enter a setup password.

Setting a device to Available enables the operating system to access the device. Hidden makes
the device unavailable. It is disabled by the BIOS and cannot be enabled by the operating system.

 Network Service
Boot

Enables or disables the ability to boot to the network using the F12 key or the boot order.

 System IDs Provides these options:

● Asset Tag—A 16-byte string identifying the workstation.

● Ownership Tag—An 80-byte string identifying ownership of the workstation. This tag appears
on the screen during POST.

● Universal Unique Identifier (UUID)—Can only be updated if the current chassis serial number
is invalid. (These ID numbers are normally set in the factory and are used to uniquely identify
the workstation.)

● Keyboard—Enables you to set the keyboard locale for System ID entry.

Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

 System Security Provides these options:

● Data Execution Prevention—Enables or disables Data Execution Prevention mode in the
CPUs. This mode prohibits code from running in pages that were set up as data pages, and
prevents attacks such as buffer overflows. Operating system support is required for this
feature.

● Virtualization Technology (VTx)—Enables or disables Intel Virtualization Technology to
increase workstation performance.

● Virtualization Technology for Directed I/O (VT–d2)Enables a virtual machine to gain exclusive
control of a hardware device, such as a graphics card.

● Embedded Security Device—This option becomes available if Embedded Device is set to
Available.

Embedded Security Device (Hidden or Available) turns the Trusted Platform Mechanism
(TPM) on and off. Device Hidden is the default. If this option is made available, the following
options become available:

◦ Power-On Authentication Support—Enables and disables an authentication feature that
requires you to enter a TPM user key password to start the workstation. This feature
uses the TPM to generate and store the authentication password.

◦ Reset Authentication Credential—Resets the authentication functionality and clears
authentication credentials.

To enable the Embedded Security Device and to access any security features associated
with the device, you must enter a setup password.

Setting a device to Available enables the operating system to access the device. Hidden
makes the device unavailable. It is disabled by the BIOS and cannot be enabled by the
operating system.

● Intel IO Virtualization—Enables or disables Virtualization Technology to increase workstation
I/O performance.

● Embedded Security Device Support—Enables the workstation to leverage the trusted
platform mechanism device.

● OS Management of Embedded Security Device—Enables or disables the ability of the
operating system to control the TPM device, including turning it on and off, initializing it, and
resetting it.

● Reset of Embedded Security Device through OS—Enables or disables the ability of the
operating system to reset the TPM.

 Setup Security
Level

Enables the administrator to set the security level of each setup feature.

Power OS Power
Management

Enables or disables:

● Runtime Power Management

● MWAITE-AWARE OS

● Idle Power Savings

● ACPI S3 Hard Disk Reset

● ACPI S3 PS/2 Mouse Wakeup

● USB Wake on Device Insertion

● Unique Sleep State Blink Rates

Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

 Hardware
Power
Management

Enables or disables:

● SATA Power Management

● Intel Turbo Boost Technology

● Enhanced Intel Turbo Boost Technology

● Eup Compliance Mode

 Thermal Enables you to set the rate of the system fan when the CPU is in idle.

Advanced2 Power-On
Options

Enables you to set the following:

● POST Messages—Enables or disables the splash screen during POST.

● F9 Prompt (Displayed or Hidden)—Selecting Displayed displays the F9=Boot Menu during
POST. Selecting Hidden prevents the text from being displayed. However, pressing F9 still
accesses the boot menu.

● F10 Prompt (Displayed or Hidden)—Selecting Displayed displays F10=Setup during POST.
Selecting Hidden prevents the text from being displayed, but pressing F10 still accesses the
Setup screen.

● F12 Prompt (Displayed or Hidden)—Selecting Displayed displays F12=Network Service
Boot during POST. Selecting Hidden prevents the text from being displayed but pressing
F12 still forces the workstation to attempt booting from the network.

● Option ROM1 prompt (Enable or Disable)—Enabling this feature causes the workstation to
display a message before loading options ROMs.

● Remote Wakeup Boot Source—Enables you to set the remote wakeup boot source as:

◦ Local Hard Drive

◦ Remote Server

● After Power Loss (On, Off, Previous State)—Enabling this option directs the previous state
to be the default.

● POST Delay (in seconds) (5, 10, 15, 20, None)—Adds a specified delay to the POST process.
This delay is sometimes needed for hard disk drives on some expansion cards that spin up
slowly (so slowly that they are not ready to start by the time POST is finished). The POST
delay also gives you time to select F10 to enter the Computer Setup (F10) Utility.

 BIOS Power-On Enables you to disable or specify a weekday and time for BIOS power-on.

 Processors Enables/disables these options:

● Hyper-Threading—Provides processor parallelization such that the operating system treats
one processor as two.

● Active Cores (1,2, or All Cores)—Selects a single core, or multiple cores per socket. (Not
available on some configurations.)

● Limit CPUID Maximum Value to 3 (Enable or Disable)—Sets the number of allowable CPU
IDs.

 Onboard
Devices

Enables you to set resources (IRQ, DMA, I/O Rate) for or disable onboard system devices such
as serial port and diskette controller. Operating system parameters generally override Onboard
Devices settings.

PCI VGA
Configuration

Configures graphics cards per workstation slots. In multi-graphics card configurations, this option
designates one card as primary graphics, and the other card as secondary graphics.

Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

 Chipset/
Memory

Enable/disable these options:

● PCI SERR# Generation (Enable or Disable)—Controls PCI SERR# generation for ill-behaved
PCI add-in cards (that can generate SERR# spuriously).

● PCI VGA Palette Snooping (Enable or Disable)—Controls PCI VGA Palette Snooping for
compatibility purposes.

● Memory Mode Interleave—Sets interleave mode for dual socket workstations.

 Device Options Enables you to set the following device options:

● Num Lock State at Power-On (On or Off)

● S5 Wake-on-LAN (Enable or Disable)

● Multiprocessor (Activates a single core.)

● Unique Sleep State Blink Rates (Enable or Disable)

● Internal speaker

● Monitor Tracking (Enable or Disable)

● NIC PXE Option ROM1 Download (Enable or Disable)

● SAS Option ROM1 Download (Enable or Disable) (Not available on some workstations.)

● SATA RAID Option ROM1 Download (Enable or Disable)

1 Available on selected models
2 These options should be used by advanced users only

Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)
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Workstation management
This section summarizes capabilities, features, and key components of workstation management,
including:

Section topics

Initial workstation configuration and deployment on page 40

Installing a remote system on page 40

Replicating the setup on page 41

Updating and managing software on page 43

HP Client Manager Software on page 43

Altiris Client Management Solutions on page 43

System Software Manager on page 44

Proactive Change Notification on page 44

Subscriber's Choice on page 44

ROM Flash on page 45

FailSafe Boot Block ROM on page 46

Workstation security on page 47

Fault notification and recovery on page 56

Dual-state power button on page 57

NOTE: Support for specific features described in this guide can vary by model and software version.

ENWW Workstation management 39



Initial workstation configuration and deployment
The workstation includes a preinstalled system software image. After a brief software unbundling
process, the workstation is ready to use.

If you prefer to replace the preinstalled software image with a customized set of system and application
software, several methods are available for deploying a customized software image, including:

● Installing additional software applications after unbundling the preinstalled software image

● Using a disk cloning process to copy the contents from one hard disk drive to another

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery
of system software, configuration management and troubleshooting, and power management.

Support for specific features described in this guide can vary by model and software version.

The best deployment method depends on the information technology environment and processes.

Installing a remote system
Remote system installation enables starting and setting up the workstation using software and
configuration information on a network server. This feature is usually used as a system setup and
configuration tool and can be used for the following tasks:

● Deploying a software image on new PCs

● Formatting a hard disk drive

● Installing application software or drivers

● Updating the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the
lower right corner of the HP logo screen. Follow the onscreen instructions to continue the installation
process. The default boot order is a BIOS configuration setting that can be changed to always attempt
a PXE boot.
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Replicating the setup
This section provides information about replicating the workstation setup.

Copying a setup configuration to a single workstation
CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target workstations are not the same model.

To copy a setup configuration:

1. Select a setup configuration to copy, and then restart the workstation.

2. As soon as the workstation powers on, press and hold F10 until you enter the Computer Setup
(F10) Utility. If necessary, press Enter to bypass the title screen.

NOTE: If you do not press F10 at the appropriate time, you must restart the workstation, and then
press and hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB media device.

4. Power off the workstation you are configuring and insert the configuration diskette into the diskette
drive or USB media device.

5. Power on the workstation you are configuring.

6. Press and hold the F10 key until you enter the Computer Setup (F10) Utility. If necessary, press
Enter to bypass the title screen.

7. Select File>Replicated Setup>Restore from Removable Media, and then follow the instructions
on the screen.

8. Restart the workstation when the configuration is complete.
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Copying a setup configuration to multiple workstations
CAUTION: A setup configuration is model-specific. If source and target workstations are not the same
model, file system corruption can result. For example, do not copy the setup configuration from an HP
xw8600 Workstation to an HP 400 Workstation.

This method takes longer to prepare the configuration diskette, but copying the configuration to target
workstations is fast.

A bootable diskette is required for this procedure. If Windows XP is not available to create a bootable
diskette, use the method for copying to a single workstation instead (see Copying a setup configuration
to a single workstation on page 41).

1. Create a bootable diskette or USB media device.

2. Select a setup configuration to copy.

3. If you are using a diskette or USB storage device, insert it now.

4. Restart the workstation.

5. As soon as the workstation powers on, press and hold F10 until you enter the Computer Setup
(F10) Utility. If necessary, press Enter to bypass the title screen.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

6. Select File>Replicated Setup>Save to Removable Media, and follow the instructions on the
screen to create the configuration diskette or USB media device.

7. Download a BIOS utility for replicating setup (repset.exe), and copy it to the configuration diskette
or USB media device. To obtain this utility, see http://www.hp.com/support/files.

8. Enter the model number of the workstation.

9. On the configuration diskette, create an autoexec.bat file containing repset.exe and cpqsetup.txt.

10. Power off the workstation you are configuring, insert the configuration diskette or USB device, and
then power on the workstation. The configuration utility runs automatically.

11. When the configuration is complete, restart the workstation.
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Updating and managing software
HP provides several tools for managing and updating software on desktops and workstations:

● HP Client Manager Software

● System Software Manager

● Altiris Client Management Solutions

● Proactive Change Notification

● Subscriber’s Choice

HP Client Manager Software
The HP Client Manager Software offers these services:

● Detailed views of hardware inventory for asset management

● PC health-check monitoring and diagnostics

● Proactive notification of changes in the hardware environment

● Web-accessible reporting of business-critical details such as thermal warnings and memory alerts

● Remote updating of system software such as device drivers and ROM BIOS

● Remote changing of boot order

● Configuration of system BIOS settings

The HP Client Management Solutions (CMS), available for download from http://www.hp.com/go/
easydeploy, are standards-based solutions for managing and controlling workstations in a networked
environment.

For more information about the HP Client Manager, see http://www.hp.com/go/ssm.

Altiris Client Management Solutions
Altiris and HP have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs.

The HP CMS is the foundation for additional Altiris Client Management Solutions that address:

● Inventory and asset management

● Deployment and migration

● Help desk and problem resolution

● Software and operations management

For more information about the following topics, go to http://www.hp.com/go/ssm:

● How HP CMS works

● Which solutions are compatible with the operating system

● How to download a fully functional, 30-day evaluation version of Altiris solutions
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System Software Manager
System Software Manager (SSM) is a utility available on Windows workstations that enables you to
update system-level software on multiple systems simultaneously. When executed on a PC client
system, SSM detects hardware and software versions and then updates the software from a central
repository, known as a file store. Driver versions supported by SSM are noted with a special icon on the
software, the driver download Web site, and on the Support Software CD.

To download the utility or to obtain more information about SSM, see http://www.hp.com/go/ssm.

Proactive Change Notification
The Proactive Change Notification application uses the Subscriber's Choice Web site to:

● Send Proactive Change Notification (PCN) e-mail informing you up to 60 days in advance of
hardware and software changes to most commercial workstations and servers

● Send you e-mail containing customer bulletins, customer advisories, customer notes, and driver
alerts for most commercial workstations and servers

You can create a profile to ensure you receive only the information relevant to the specific IT
environment.

To learn more about the PCN application and to create a custom profile, see Subscriber's Choice
on page 44.

Subscriber's Choice
Subscriber’s Choice is a client-based service from HP that supplies you with personalized product tips,
feature articles, and driver and support alerts and notifications based on the profile.

Subscriber’s Choice Driver and Support Alerts and Notifications delivers e-mail notifying you that the
information you subscribed to in the profile is available for review and retrieval.

To learn more about Subscriber’s Choice and create a custom profile, see http://www.hp.com/go/
subscriberschoice.

44 Chapter 4   System management ENWW

http://www.hp.com/go/ssm
http://www.hp.com/go/subscriberschoice
http://www.hp.com/go/subscriberschoice


ROM Flash
HP workstations include a programmable flash ROM. By establishing a setup password in the Computer
Setup (F10) Utility, you can protect the ROM from being inadvertently updated or overwritten. This
function is important to ensure the operating integrity of the workstation.

To upgrade the ROM, download the latest SoftPaq images from http://www.hp.com/support/
workstation_swdrivers.

For maximum ROM protection, establish a setup password. The setup password prevents unauthorized
ROM upgrades. SSM enables you to create the setup password on several workstations simultaneously.

Remote ROM Flash
Remote ROM Flash allows system administrators to safely upgrade the ROM on remote HP
workstations from a centralized network management console, resulting in a consistent deployment of,
and greater control over, HP PC ROM images over the network.

To use Remote ROM Flash, the workstation must be powered on, or turned on using Remote Wakeup.

For more information about Remote ROM Flash and HPQFlash, see the HP Client Manager Software
or System Software Manager sections at http://www.hp.com/go/ssm.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on PCs using a Windows
operating system. For more information about HPQFlash, see http://www.hp.com/go/ssm, and enter the
name of the workstation.
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FailSafe Boot Block ROM
The FailSafe Boot Block ROM enables system recovery in the unlikely event of a ROM flash failure. For
example, if a power failure occurs during a ROM upgrade, the Boot Block uses a flash-protected section
of the ROM to verify a valid system ROM flash when power is restored to the workstation.

If the system ROM is valid, the workstation starts normally.

If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support to
start the workstation from a BIOS image CD created from a SoftPaq. The BIOS image CD programs
the system ROM with a valid image.

When Boot Block detects an invalid system ROM, the workstation power LED blinks red eight times and
the workstation beeps eight times; then the workstation pauses for two seconds. On some models, a
Boot Block recovery mode message appears.

In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image
CD.

Recovering the workstation from Boot Block Recovery mode
To recover the workstation after it enters Boot Block recovery mode:

1. If there is media in the diskette or optical disk drives, remove it.

2. Insert a BIOS image CD into the CD drive.

You can also use USB media such as an HP DriveKey.

3. Power off, then power on the workstation.

If no BIOS image CD or USB media is found, you are prompted to insert one and restart the
workstation.

If a setup password has been established, the Caps Lock light illuminates and you are prompted
for the password.

4. Enter the setup password.

If the workstation starts from the CD or USB media and successfully reprograms the ROM, three
keyboard lights illuminate. A rising-tone series of beeps also signals successful recovery.

5. Remove the CD or USB media and power off the workstation.

6. Restart the workstation.
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Workstation security
This section provides information about providing system security through asset tracking, password
security, hard disk drive locking, and chassis locks.

Asset tracking
Asset tracking features incorporated into the workstation provide asset tracking data that can be
managed using HP Systems Insight Manager (HP SIM), HP CMS, or other systems-management
applications.

Seamless, automatic integration between asset tracking features and these products enables you to
choose the management tool that is best suited to the environment and to leverage investments in
existing tools.

HP also offers several solutions for controlling access to valuable components and information:

● HP ProtectTools Embedded Security prevents unauthorized access to data, checks system
integrity, and authenticates third-party users attempting system access.

● Security features such as ProtectTools and the Side access panel sensor (Smart Cover Sensor)
help prevent unauthorized access to the data and to the internal components of the workstation.

● By disabling parallel, serial, or USB ports, or by disabling removable-media boot capability, you
can protect valuable data assets.

● Memory Change and Side access panel sensor (Smart Cover Sensor) alerts can be forwarded to
system management applications to deliver proactive notification of tampering with a workstation’s
internal components.

ProtectTools, the Side access panel sensor (Smart Cover Sensor), and the Side access panel solenoid
lock (Hood Lock) are available as options on select systems.

Use the following utilities to manage security settings on the HP workstation:

● Locally, using the Computer Setup (F10) Utility

● Remotely, using the HP CMS or System SSM, which enables the secure, consistent deployment
and control of security settings from a simple command line utility

For more information about the Computer Setup (F10) Utility, see The Computer Setup (F10) Utility
menu on page 32.

The following table and sections refer to the management of workstation security through the Computer
Setup (F10) Utility

Table 4-2   Security features overview

Feature Purpose How it is established

Removable Media Boot Control Prevents booting from removable media
drives

From the Computer Setup (F10)
Utility menu

Serial, Parallel, USB, or Infrared
Interface Control

Prevents transfer of data through the
integrated serial, parallel, USB, or infrared
interface

From the Computer Setup (F10)
Utility menu

Power-On Password Prevents use of the workstation until the
password is entered (applies to initial system
startup and restarts)

From the Computer Setup (F10)
Utility menu
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Feature Purpose How it is established

Setup Password Prevents reconfiguration of the workstation
(use of the Setup utility) until the password is
entered

From the Computer Setup (F10)
Utility menu

Network Server Mode Provides unique security features for
workstations used as servers

From the Computer Setup (F10)
Utility menu

SATA hard disk drive security
HP workstations include the HP DriveLock facility for SATA hard disk drives to prevent unauthorized
access to data.

WARNING! Enabling DriveLock can render a SATA hard disk drive permanently inaccessible if the
master password is lost or forgotten. No method exists to recover the password or access the data.

DriveLock has been implemented as an extension to Computer Setup (F10) functions. It is only available
when hard disk drives that support the ATA security command set are detected. On HP workstations,
it is not available when the SATA emulation mode is RAID+AHCI or RAID.

DriveLock is for HP customers for whom data security is a paramount concern. For such customers, the
cost of a hard disk drive and the loss of the data stored on it is inconsequential when compared to the
damage that could result from unauthorized access to its contents.

To balance this level of security with the need to address the issue of a forgotten password, the HP
implementation of DriveLock employs a two-password security scheme. One password is intended to
be set and used by a system administrator, while the other is typically set and used by the user.

No "back door" can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is most
safely used when the data contained on the hard disk drive is replicated on a corporate information
system or is regularly backed up.

If both DriveLock passwords are lost, the hard disk drive is rendered unusable. For users who do not fit
the previously defined customer profile, this might not be acceptable. For users who fit this profile, it
might be a tolerable risk, given the nature of the data stored on the hard disk drive.

Table 4-2   Security features overview (continued)

48 Chapter 4   System management ENWW



DriveLock applications

The most practical use of DriveLock is in a corporate environment. The system administrator would be
responsible for configuring the hard disk drive, which involves setting the DriveLock master password
and a temporary user password. If you forget the user password or if the equipment is passed on to
another employee, the master password can be used to reset the user password and regain access to
the hard disk drive.

HP recommends that corporate system administrators who enable DriveLock also establish a corporate
policy for setting and maintaining master passwords. This should be done to prevent a situation where
an employee sets both DriveLock passwords before leaving the company. In such a scenario, the hard
disk drive is unusable and requires replacement. Likewise, by not setting a master password, system
administrators might find themselves locked out of a hard disk drive and unable to perform routine
checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users
in this category include personal users, or users who do not maintain sensitive data on their hard disk
drives as a common practice. For these users, the potential loss of a hard disk drive resulting from
forgetting both passwords is much greater than the value of the data DriveLock protects.

Access to Computer Setup (F10) and DriveLock can be restricted through the setup password. By
specifying a setup password and not giving it to users, system administrators can restrict users from
enabling DriveLock.

Using DriveLock

When hard disk drives that support the ATA security command set are detected, DriveLock appears
under the Security menu in the Computer Setup (F10) menu. You are presented with options to set the
master password and to enable DriveLock. You must provide a user password to enable DriveLock.
Because the initial configuration of DriveLock is typically performed by a system administrator, a master
password should be set first.

HP encourages system administrators to set a master password whether they plan to enable DriveLock
or not. This gives the administrator the ability to modify DriveLock settings if the drive is locked in the
future. After the master password is set, the system administrator can enable DriveLock or leave it
disabled.

If a locked hard disk drive is present, POST requires a password to unlock the device. If a power-on
password is set and it matches the device’s user password, POST does not prompt the user to re-enter
the password. Otherwise, the user is prompted to enter a DriveLock password.

For a cold start, use the master or user password. For a warm start, enter the same password used to
unlock the drive during the preceding cold start.

Users have two attempts to enter a correct password. During cold start, if neither attempt succeeds,
POST continues but the drive remains inaccessible. During a warm-start or restart from Windows, if
neither attempt succeeds, POST halts and the user is instructed to cycle power.
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Enabling DriveLock

To enable and set the DriveLock user password:

1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation, and then press
and hold F10 again to access the utility.

If you are using a PS2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>DriveLock Security.

4. For each DriveLock-capable drive, select a drive by pressing F10 to accept.

5. Under Enable/Disable DriveLock options, select Enable, and then press F10  to enable DriveLock
for a specific drive.

CAUTION: Forgetting the DriveLock password renders the drive unusable.

6. Enter a new user password, and then press F10 to accept. This password may be 1 to 32 characters
long.

7. Enter the password again in the Enter New Password Again field. If you forget this password, the
drive is rendered permanently disabled.

8. Select File>Save Changes and Exit, and then press F10. After you press F10, the workstation
performs a cold start before invoking the DriveLock function.

You can also use this process to set the DriveLock master password by selecting Master in Step
5.

When the workstation starts, you are prompted to enter the DriveLock password for each
DriveLock-capable drive for which you have set a password. You have two attempts to enter the
password correctly. If the password is not entered correctly, the workstation attempts to start
anyway. However, the boot process most likely fails because data from a locked drive cannot be
accessed.

In a single drive workstation, if the drive has DriveLock enabled, the workstation might not be able
to boot to the operating system, and might try to boot from the network or from another storage
device (depending on the boot ordering options). Regardless of the outcome of the start attempts,
the drive-locked drive remains inaccessible without the DriveLock password.

In a two-drive workstation that has a boot drive and a data drive, you can apply the DriveLock
feature to the data drive only. In this case, the workstation can always start, but the data drive is
accessible only when the DriveLock password is entered.

Cold starts require that you enter DriveLock passwords. However, DriveLock passwords are also
required for warm starts. For example, if you boot to DOS and press Ctrl+Alt+Del, you must enter
the DriveLock password before the workstation completes the next start cycle. This warm-start
behavior is consistent with the DriveLock feature.
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Password security
The power-on password prevents unauthorized use of the workstation by requiring entry of a password
to access applications or data when the workstation is powered on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override to the power-on password. When prompted for the power-on password, entering the setup
password instead enables access to the workstation.

You can establish a network-wide setup password to enable the system administrator to log in to all
network systems to perform maintenance without needing to know the power-on password.

Establishing a setup password using Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
workstation (through the use of the Computer Setup (F10) Utility) until the password is entered.

To establish a setup password using the Computer Setup (F10) menu:

1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold  F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation, and then press
and hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Setup Password and then follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.
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Establishing a power-on password using workstation setup

Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
workstation when power is connected, unless you specify the password. When a power-on password
is set, the Computer Setup (F10) Utility presents Password Options in the Security menu. The password
options include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, you must enter the password when the workstation is powered
on, when the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, you
must enter the password. The password must also be entered each time the workstation is restarted.
When Network Server Mode is enabled, the password prompt is not presented during POST, but an
attached PS/2 keyboard remains locked until you enter the power-on password.

To enable Network Server Mode, you must set a power-on password under Advanced>Password
Options. This option enables the workstation to start without requiring the power-on password, but the
keyboard and mouse are locked until you enter the password. The keyboard LEDs rotate constantly
when the workstation is in locked mode.

To establish a power-on password through the Computer (F10) menu:

1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation and then press
and hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Power-On Password and then follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.

Entering a power-on password

To enter a power-on password:

1. Restart the workstation.

2. When the key icon appears on the monitor, enter the current password, and then press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you will enter the F10 setup screen with read-only permission. (See the Setup Browse Mode option
under the Power-On options.)
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Entering a setup password

If a setup password has been established on the workstation, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.

To enter a setup password:

1. Restart the workstation.

2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation and press and
hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. When the key icon appears on the monitor, enter the setup password, and press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.

Changing a power-on or setup password

To change a power-on or setup password:

1. Restart the workstation.

2. To change the power-on password, go to step 4.

3. To change the setup password, as soon as the workstation is powered on, press and hold F10 until
you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation, and then press
and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

4. When the key icon appears, enter the current password, a slash (/) or alternative delimiter
character, the new password, another slash (/) or alternative delimiter character, and the new
password again as shown: 

current password/new password/new password

For information about the alternative delimiter characters, see National keyboard delimiter
characters on page 54.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

5. Press Enter.

The new password takes effect the next time you power on the workstation.

The power-on and setup passwords can also be changed using the Security options in the Computer
Setup (F10) Utility.
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Deleting a power-on or setup password

To delete a power-on or setup password:

1. Power on or restart the workstation.

2. Choose from the following:

● To delete the power-on password, go to step 4.

● To delete the setup password, as soon as the workstation is powered on, press and hold
F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen,
if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation and then
press and hold F10 again to access the utility.

Use the appropriate operating system shutdown process.

3. When the key icon appears, enter the current password followed by a slash (/) or alternative
delimiter character: current password/.

For information about the alternative delimiter characters see National keyboard delimiter
characters on page 54.

4. Press Enter.

National keyboard delimiter characters

Each keyboard meets country-specific requirements. The syntax and keys you use for changing or
deleting passwords depend on the keyboard included with the workstation.

Table 4-3  National keyboard delimiter characters

Language Delimiter Language Delimiter Language Delimiter

Arabic / Greek - Russian /

Belgian = Hebrew . Slovakian -

BHCSY * - Hungarian - Spanish -

Brazilian / Italian - Swedish/Finnish /

Chinese / Japanese / Swiss -

Czech - Korean / Taiwanese /

Danish - Latin American - Thai /

French ! Norwegian - Turkish .

French
Canadian

é Polish - U.K. English /

German - Portuguese - U.S. English /

* Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

54 Chapter 4   System management ENWW



Clearing passwords

If you forget the password, you cannot access the workstation.

For instructions about clearing passwords, see Configuring password security and resetting CMOS
on page 154.

Chassis security

Side access panel sensor (Smart Cover Sensor) (optional)

The optional Side access panel sensor is a combination of hardware and software technology that can
alert you when the workstation side access panel has been removed (if the sensor has been configured
in the Computer Setup (F10) Utility).

The three levels of Side access panel sensor protection are shown in the following table:

Table 4-4  Side access panel sensor protection levels

Level Setting Description

Level 0 Disabled Side access panel sensor * is disabled (default).

Level 1 Notify User When the workstation restarts, a message appears indicating that the
workstation side access panel has been removed.

Level 2 Setup Password When the workstation is restarted, a message appears indicating that the
workstation side access panel has been removed. You must enter the setup
password to continue.

* Side access panel sensor settings can be changed using the Computer Setup (F10) Utility.

Setting the side access panel sensor protection level

To set the side access panel sensor protection level:

1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the Computer Setup (F10) Utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Smart Cover>Cover Removal Sensor, and follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.

Side access panel solenoid lock

The side access panel solenoid locks the side access panel to the chassis. The solenoid is controlled
by a local or remote signal.

To lock the solenoid, set a password for the solenoid lock in the Computer Setup (F10) Utility. To unlock
the solenoid, remove the solenoid lock password in the Computer Setup (F10) Utility.

The solenoid lock FailSafe Key–available from HP–is is a device for manually disabling the solenoid
lock. You will need the FailSafe Key in case of forgotten password, power loss, or workstation
malfunction.
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Cable lock (optional)

To prevent theft, the rear chassis panel of the workstation accommodates a keyed cable lock. This cable
lock attaches to the chassis and secures it to the work area.

Fault notification and recovery
Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.

If the workstation is connected to a network that is managed by HP CMS, the workstation sends a fault
notice to the network management application. With HP CMS, you can also remotely schedule
diagnostics to run on managed PCs and create a summary report of failed tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into hard disk drives and is installed in select
HP workstations. The DPS helps diagnose problems that might result in unwarranted hard disk drive
replacement.

When HP workstations are built, each installed hard disk drive is tested using the DPS, and a permanent
record of key information is written onto each drive. Every time the DPS is run, test results are written
to the hard disk drive. The service provider can use this information to help diagnose conditions that
required you to run the DPS software.

ECC fault prediction
When the workstation encounters an excessive number of error checking and correcting (ECC) memory
errors, it displays a local alert message. This message contains information about the errant DIMM,
enabling you to take action before you experience noncorrectable memory errors. ECC DIMMs are
standard on this workstation.

Thermal sensors
Several thermal sensors in the HP Workstation regulate workstation fans to maintain an acceptable,
efficient chassis temperature.
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Dual-state power button
With ACPI enabled, the power button can function as an on/off switch or as a button. This feature does
not completely turn off power, but instead causes the workstation to enter a low-power standby state.
This enables you to go to standby without closing applications, and to return to the same operational
state without any data loss.

Changing the power button configuration
To change the power button configuration:

1. Select Start, and then select Control Panel>Power Options.

2. In Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Hibernate. 

NOTE: Hibernate must be enabled in the Hibernate tab.

After configuring the power button to function as a button, you can press the power button to put the
workstation in a very low power state. Press the button again to bring the workstation out of this low
power state to full power state. To completely turn off power to the workstation, press and hold the power
button for four seconds.

CAUTION: Do not use the power button to power off the workstation unless the system is not
responding; turning off the power without operating system interaction can cause data loss.
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5 Replacing components

This chapter presents removal and installation procedures for most internal workstation components. It
includes these topics:

Topics

Warnings and cautions on page 59

Service considerations on page 60

Customer self-repair on page 64

Removing and installing components on page 65

Product recycling on page 107
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Warnings and cautions
WARNING!  Any surface or area of the equipment marked with this symbol indicates the presence
of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To reduce
the risk of injury from a hot component, enable the surface to cool before touching.

WARNING!  Any surface or area of the equipment marked with this symbol indicates the presence
of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any enclosed
area marked with this symbol.

WARNING! To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper
workstation setup, posture, health, and work habits for computer users, and provides important electrical
and mechanical safety information. This guide is located at http://www.hp.com/ergo and on the
documentation CD (if one is included with the product).

WARNING! If a product is shipped in packaging marked with this symbol, , the product must always

be lifted by two persons to avoid personal injury due to product weight.

CAUTION: Static electricity can damage the electronic components of the workstation. Before
beginning these procedures, be sure you discharge static electricity by briefly touching a grounded metal
object.

CAUTION: Observe the following cautions when removing or replacing a processor:

— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller
or service provider to install the processor. If you plan to install the processor yourself, read all of the
instructions carefully before you begin.

— Failure to follow the workstation preparation instructions can result in an improperly installed
processor, causing extensive workstation damage.

— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor
in the socket.

CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body
to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap, and peripheral units to that piece of equipment.

NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested
for reliability and are manufactured to high quality standards.
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Service considerations
Review the following sections, which describe service considerations, before removing and replacing
system components.

WARNING!  Do not use the front bezel as a handle or lifting point when lifting or moving the
workstation. Lifting the workstation from the front bezel, or lifting it incorrectly, could cause the
workstation to fall, causing possible injury to you and damage to the workstation. To properly and safely
lift the workstation, use the handles. If the workstation is not equipped with handles, lift from the bottom
of the workstation.

Cautions, warnings and safety precautions
For safety, review the cautions, warnings, and safety precautions before accessing the workstation
components. Also, review the Safety and Regulatory Guide that came with the workstation for more
information.

ESD information

Generating static
The following table shows that different activities generate different amounts of static electricity. Static
electricity increases as humidity decreases.

Relative humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

7,500V

3,000V

400V

15,000V

5,000V

800V

35,000V

12,000V

6,000V

Removing bubble pack from PCB

Packing PCBs in foam-lined box

7,000V

5,000V

20,000V

11,000V

26,500V

21,000V

CAUTION: Static electricity in the amount of 700 volts might degrade a product.
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Preventing ESD equipment damage
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories:

● Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand contact.

● Protect electrostatic parts and assemblies with nonconductive or approved containers or
packaging.

● Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from containers.

● When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Personal grounding methods and equipment
Use the following items to help prevent ESD damage:

● Wrist straps—These are flexible straps with a maximum of one megohm ± 10% resistance in the
ground cords. To provide a proper ground, wear the strap against bare skin. The ground cord must
be connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps, toe straps, and boot straps—These can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one megohm ± 10% resistance between the operator and
ground.

The following table shows protection levels available from static shielding materials.

Table 5-1  Static shielding protection levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500V

7,500V

15,000V

This section provides guidelines to prevent ESD damage to equipment.
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Grounding the work area
To prevent static damage in the work area:

● Cover the work surface with approved static-dissipative material. Use a wrist strap connected to
the work surface, and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only in static-free work areas.

● Disconnect power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials, such as plastic assembly aids and Styrofoam.

● Use field service tools (such as cutters, screwdrivers, and vacuums) that are conductive.

Recommended ESD prevention materials and equipment
The recommended materials and equipment are:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with a ground cord of one megohm ± 10% resistance

● Static-dissipative table or floor mats with a hard-tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one megohm ± 10% resistance

● Material-handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes
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Tools and software requirements
The tools necessary for workstation component removal and installation are:

● Torx T-15 driver

● Flat blade and cross-tip screwdrivers

● Diagnostics software

Special handling of components
The components included in this section require special handling when servicing the workstation.

WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation.
Lifting the workstation from the front bezel, or lifting it incorrectly, could cause the workstation to fall,
causing possible injury to you and damage to the workstation. To properly and safely lift the workstation,
lift from the bottom of the workstation.

Cables and connectors
Handle cables with care to avoid damage. Apply only the tension required to seat or unseat cables
during insertion or removal from the connector. When possible, handle cables by the connector or pull-
strap. In all cases, avoid bending or twisting the cables, and be sure that the cables are routed in such
a way that they cannot be caught or snagged by parts being removed or replaced.

When servicing the workstation, be sure that cables are placed in their proper location during the
reassembly process. Improper cable placement can damage the workstation.
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Hard disk drives
Hard disk drives are fragile, precision components. Avoid subjecting them to physical shock and
vibration. The following guidelines apply to all drives, including failed drives, replacement drives, and
spares.

● Do not remove hard disk drives from the shipping package for storage. Keep hard disk drives in
their protective packaging until they are mounted in the workstation.

● Avoid dropping hard disk drives from any height.

● If you are inserting or removing a hard disk drive, power off the workstation. Do not remove a hard
disk drive while the workstation is powered on or in standby mode.

● Before handling a drive, be sure that you discharge static electricity. While handling a drive, avoid
touching the connector. For more information about preventing electrostatic damage, see ESD
information on page 60.

To prevent possible ESD damage when the drive is installed, connect the drive power cable before
connecting the data cable. This discharges accumulated static electricity through the drive power
cable to the workstation chassis.

● When inserting a drive, do not use excessive force.

● Avoid exposing a hard disk drive to liquids, temperature extremes, or products with magnetic fields
such as monitors or speakers.

Lithium coin cell battery
The battery included with the workstation provides power to the real-time clock and has a lifetime of
about three years.

For instructions on battery removal and replacement, see Battery on page 96.

WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short the external contacts, dispose
of in water or fire, or expose the battery to temperatures higher than 60° Centigrade (140° Fahrenheit).

NOTE: Do not dispose of batteries, battery packs, and accumulators with general household waste.

Customer self-repair
Under the Customer Self-Repair program, you can order a replacement part and install the part without
onsite HP technical assistance. See http://www.hp.com/go/selfrepair/ for information on the program as
customer self-repair may be required for some components.
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Removing and installing components
Component locations

The following illustration and table identify workstation system board components.

Figure 5-1  System board component locations

Table 5-2  System board components ID

Item Component Item Component Item Component

1 CPU fan 12 Clear CMOS button 23 PCI 32/33

2 Rear chassis fan 13 Front power button/LED 24 PCIe2 x16

3 CPU power 14 Crisis recovery jumper 25 PCIe x8(4)

4 Solenoid hood lock 15 Front chassis fan 26 PCIe2 x16

5 CPU socket 16 HDD LED 27 PCIe2 x8(4)

6 Memory sockets 17 Internal USB 1/DASH 28 Audio

7 Main power 18 SATA ports 29 Network/USB

8 Battery 19 Internal USB 2 30 USB

9 Floppy disk drive 20 Front USB 31 Keyboard/mouse

10 Password jumper 21 Speaker 32 Serial

11 Chassis intrusion switch 22 Front audio  

For related system architecture information, see System board architecture on page 1.
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Predisassembly procedures
Perform the following steps before servicing a workstation:

1. Review the safety information and precautions in Warnings and cautions on page 59 and the Safety
and Regulatory Information for the workstation.

2. Locate and clear a suitable work area.

3. Close all open software applications.

4. Remove all diskettes, CDs, and DVDs from the workstation.

5. Shut down the operating system.

6. Power off the workstation and all peripheral devices connected to it.

7. Remove or disengage security devices that prevent you from opening the workstation.

8. Disconnect the power cord from the electrical outlet and then from the workstation.

9. Disconnect peripheral device cables from the workstation.

10. Gather the tools.

11. Service the workstation.

12. Restore power to the workstation when servicing is done.
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Disassembly order
For convenience, disassembly procedures should be followed in a particular order. Use the following
table to determine the sequence in which to access major workstation components.

Table 5-3  Workstation component installation

To install/
replace...

Remove... Then remove... Then remove... Then remove... Then remove...

Battery, front
bezel, hard drive,
memory, power
supply, rear
system fan, side
access panel
sensor, or
solenoid lock

Chassis lock Side access
panel

   

Processor Chassis lock Side access
panel

Heatsink   

Expansion card
(PCI/PCIe)

Chassis lock Side access
panel

Expansion card
support

Expansion card
slot cover

Front panel I/O
assembly, optical
bay filler, optical
drive, power
button assembly,
or system
speaker

Chassis lock Side access
panel

Front bezel   

System board Chassis lock Side access
panel

Expansion card
support

Expansion cards
or DIMMs

Heatsink

Cable lock (optional)
NOTE: Read Warnings and cautions on page 59 before servicing this component.

If a cable lock is installed on the workstation, remove it before servicing the workstation.

Unlock it and pull it out of the cable lock slot as shown in the following figure.
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Figure 5-2  Removing the cable lock
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Side access panel
NOTE: Read Warnings and cautions on page 59 before servicing this component.

Before accessing the internal components of the workstation, you must remove the side access panel.

This section describes how to remove and install the side access panel.

Removing the side access panel
To remove the side access panel:

WARNING! Before removing the workstation side access panel, be sure that the workstation is
powered off and that the power cord is disconnected from the electrical outlet.

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove locks that are present such as a cable lock.

3. Pull up on the handle , slide the cover 1/2-inch towards the rear of the system 2, then rotate the
cover off the chassis  as shown in the following figure.

Figure 5-3  Removing the side access panel

Installing the side access panel
To install the side access panel:

1. Align the bottom groove of the side panel with the bottom edge of the chassis.

2. Rotate the side panel toward the chassis, slide the panel forward to engage the fingers on the top
cover as well as the latch, then press firmly until the latch engages.
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Side access panel sensor (optional)
NOTE: Read Warnings and cautions on page 59 before servicing this component.

The side access panel sensor is a remote solenoid that detects when the side access panel is opened.

This section describes how to remove and install the sensor.

Removing the side access panel sensor
To remove the side access panel sensor:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

Remove the side access panel (see Removing the side access panel on page 69).

3. Disconnect the sensor cable from the inline chassis cable as shown below .

Figure 5-4  Removing the side access panel sensor

4. Slide the sensor back in its slot, push the sensor down, and then remove it from the chassis 2.

Installing the side access panel sensor
To replace the side access panel sensor, reverse the previous steps.

NOTE: The metal bracket where the sensor resides is part of the sensor kit and must be installed when
installing a sensor for the first time.
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Side access panel solenoid lock
The side access panel solenoid lock provides a method to lock the side access panel by means of a
local or remote signal-controlled solenoid.

This section describes how to remove and install the side access panel solenoid lock.

Removing the side access panel solenoid lock
To remove the side access panel solenoid lock:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

Remove the side access panel (see Removing the side access panel on page 69).

3. Disconnect the side access panel solenoid lock cable from the system board .

4. Remove the two screws that fasten the solenoid lock to the chassis 2 as shown in the following
figure.

5. Pull the solenoid lock assembly inward and then up  to remove the assembly from the chassis.

Figure 5-5  Removing the side access panel solenoid lock

Installing the side access panel solenoid lock
Reverse the above steps to install the side access panel solenoid lock. This involves connecting the
solenoid lock cable to the system board and fastening the solenoid lock to the chassis.
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Bezel
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install the front chassis bezel.

Removing the front bezel
To remove the front bezel:

1. Remove the side access panel (see Removing the side access panel on page 69).

2. Lift the release tabs , and then rotate the front bezel off the chassis 2.

Installing the front bezel
To install the front bezel, align the tabs discussed in the previous section and rotate the bezel until it
snaps in place.

Front panel I/O device assembly
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install a front panel I/O device assembly.

Removing the front panel I/O device assembly
To remove the front panel I/O device assembly:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66 ).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the front bezel (see Removing the front bezel on page 72).
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4. Remove the fastening screws from the I/O device assembly and remove it from the chassis as
shown in the following figure.

Figure 5-6  Removing the front panel I/O device assembly

5. Disconnect the front panel I/O device assembly cables from the system board as shown below.

Figure 5-7  Disconnecting the front panel I/O cables

6. Carefully guide the front panel I/O device assembly from the chassis.
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Installing the front panel I/O device assembly
To instal the front panel I/O device assembly:

1. Guide the front panel I/O device assembly cables through the chassis openings from which they
were removed.

2. Place the front panel I/O device assembly in the chassis, and then install the fastening screws in
reverse order as they were removed.

3. Connect the front panel I/O audio  and USB 2 cables to the system board as shown in the
following diagram.

NOTE: The front panel I/O device assembly also has a 1394a cable that should be clipped to the
bottom of the chassis in the plastic clip if it is not used or it can be connected to an optional 1394
expansion card.

Figure 5-8  Connecting the front panel I/O device cables

74 Chapter 5   Replacing components ENWW



Power button assembly
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install the power button assembly.

Removing the power button assembly
To remove the power button assembly:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the front bezel (see Removing the front bezel on page 72).

4. Disconnect the power button cable from the system board as shown next.

Figure 5-9  Disconnecting the power button cable

5. From inside of the chassis, pull the tabs  away from the chassis sides.
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6. Pull the power button assembly 2 from the chassis.

Figure 5-10  Removing the power button assembly

Installing the power button assembly
To replace the power button assembly, reverse the previous steps.
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Optical disk drive
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install an optical disk drive.

Removing an optical disk drive from the optical bay
1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the front bezel (see Removing the front bezel on page 72).

4. Disconnect the data  and power 2 cables from the optical disk drive as shown in the following
figure.

Figure 5-11  Disconnecting optical disk drive cables
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5. Lift the green drive-lock release lever  and gently slide the drive out of the chassis 2 as shown
in the following figure.

Figure 5-12  Removing the optical disk drive
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Installing an optical disk drive in the optical bay
To install an optical disk drive:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the front bezel (see Removing the front bezel on page 72).

4. Lift the green release lever  and slide the optical disk drive into the bay until it is stopped by the
release latch as shown in the figure below.

Release the latch and continue sliding the drive until the latch closes and engages the drive 2.

Figure 5-13  Installing the optical disk drive

TIP: During installation the adjacent drive or filler may move slightly. It might be necessary to
slide and align both devices to get the release latch to close and engage both devices.

5. Connect the power and data cables to the drive as shown in the following figure. (See the service
label on the Side access panel for component locations.)
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6. Connect the optical disk drive data cable to the appropriate SATA port on the system board as
shown in the following figure.

Figure 5-14  Connecting power and data cables
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Workstation speaker
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install the workstation speaker.

Removing the workstation speaker
To remove the workstation speaker:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the front bezel (see Removing the front bezel on page 72).

4. Disconnect the speaker cable from the system board  as shown in the figure below.

5. Remove the two screws as shown 2.

6. Slide the speaker away from the chassis and remove it from the chassis .

Figure 5-15  Removing the workstation speaker

Installing the workstation speaker
To install the speaker, reverse the previous steps.
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Power supply
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install a power supply.

Removing the power supply
To remove the power supply:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the four screws from the rear of the chassis .

4. Disconnect all of the power supply cables from the system board and all peripheral devices (hard
drives, optical drives, and others as needed).

5. Slide the power supply inward then up to remove it from the chassis 2.

Figure 5-16  Removing power supply

Installing the power supply
To install the power supply, reverse the previous steps.
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Power connections
NOTE: Read Warnings and cautions on page 59 before servicing this component.

For help with identifying power cables, see the following figure and table. Ensure that all cables are
routed or tied so they cannot interfere with the processor heatsink fans.

Figure 5-17  Power connector identification for a typical configuration

Table 5-4  Power connector description

Item Description Item Description

A Power supply G (P8) Optical drive

B (P1) Main power H (P9) Floppy diskette drive

C (P3) CPU power I (P10) Hard drive

D (P12) PCIe auxiliary power J (P11) Hard drive

E (P4/P5) Optical drive K (P13) Auxiliary/diskette drive

F (P6/P7) Optical drive   
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Rear system fan assembly
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install the rear system fan assembly.

Removing the rear system fan assembly
To remove the rear system fan assembly:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Disconnect the rear system fan assembly cable  from the system board as shown in the following
figure.

Figure 5-18  Disconnecting fan wires

4. Remove the four screws from the rear of the chassis 2, and then pull the fan assembly inward and
then up  out of the chassis.

Installing the rear system fan assembly
To install the rear system fan assembly, reverse these steps.
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Memory
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section presents memory module (DIMM) configuration information and removal/installation
procedures.

DIMM installation guidelines

● Install only HP-approved DDR3 DIMMs

CAUTION: HP only ships DIMMs that are electrically and thermally compatible with this
workstation. Because third-party DIMMs might not be electrically or thermally compatible, they are
not supported by HP.

● Use only industry-standard ECC unbuffered DIMMS. See http://www.hp.com/go/quickspecs to find
which DIMMs are compatible with the workstation.

DIMM installation order
Review the following to determine the correct installation order for DIMMs.

Figure 5-19  DIMM load order

Supported DIMM configurations
The workstation supports these DIMM configurations:

● Four DIMM slots

● Memory configuration from 1 GB to 16GB

● No support for mirroring

● No support for DIMM sparing
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BIOS errors and warnings
The BIOS generates warnings/errors on invalid memory configurations:

● If the BIOS can find a valid memory configuration by disabling plugged-in memory, it does so and
reports a warning during POST. the workstation can still be started. The warning will indicate the
location of the failed DIMM on the system board or memory riser.

● If there is no way for the BIOS to obtain a valid memory configuration by disabling plugged-in
memory, the BIOS halts with a diagnostics 2006 code for memory error (five beeps and blinks).
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Removing a DIMM
To remove a DIMM:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

CAUTION: To ensure that DIMMs are not damaged during removal or installation, power off the
workstation and unplug the power cord from the AC power outlet. If you do not unplug the power
cord before installing memory, the modules might be damaged and the workstation will not
recognize the memory changes.

3. Push gently outward on the DIMM socket levers  as shown in the following figure.

Figure 5-20  Removing a DIMM

4. Lift the DIMM straight up 2 and out of the socket, then store the DIMM in an antistatic bag.
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Installing a DIMM
To install the DIMM:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Push gently outward on the DIMM socket levers as shown in the following figure.

Figure 5-21  Opening DIMM socket levers
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4. Align the DIMM connector key with the DIMM socket key, and then seat the DIMM firmly in the
socket  as shown in the following figure.

CAUTION: DIMMs and their sockets are keyed for proper installation. To prevent socket or DIMM
damage, align these guides properly when installing DIMMs.

Figure 5-22  Seating the DIMM

5. Secure the socket levers 2.
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Expansion card slot identification
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section identifies and describes workstation expansion card slots, and presents card configuration
information.

Slot identification and description
The following figure identifies workstation expansion card slots.

Figure 5-23  Identifying expansion card slots

The following table describes the workstation PCIe card slots.

Table 5-5  PCI slots

Slot Type Slot power

(Maximum)

1 PCIe2 - x8(4) 25W

2 PCIe2 - x16 75W 75W

3 PCIe - x8(4) 25W

4 PCIe2 - x16 75W 75W

5 PCI 32/33 25W

6 PCI 32/33 25W

NOTE: The x1, x4, x8, and x16 designators describe the number of electrical PCIe lanes routed to an
expansion slot. For example, x16(8) means that the expansion slot is mechanically a x16 length
connector, with eight PCIe lanes connected. A x16 graphics card runs at the bandwidth of the slot it is
plugged into.

Slots one and three use open-ended PCIe connectors, so a PCIe x16 card can be inserted. Graphics
cards greater than 75 watts require the use of an auxiliary power cable adapter.
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Card configuration restrictions for power supplies
CAUTION: To prevent damage, the overall power consumption of the workstation (including I/O cards,
CPU, and memory) must not exceed the maximum rating of the workstation power supply. For power
supply information, see Power supply specificationson page 9.

The maximum graphics configuration with an 475W power supply can include two 75-watt cards (one
in slot two, one in slot four), or one 150-watt card in slot two or slot four.

If a graphics card greater than 75 watts is used, leave the adjacent slot empty. The maximum graphics
power is dependent on CPU and memory selections. Follow any additional workstation configuration
restrictions.
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Choosing an expansion card slot
Whenever possible, use the following tips to help you select the proper slot for an expansion card:

● Insert the primary graphics card in a PCIe x16 slot intended for graphics.

● Insert a second graphics card in a second PCIe x16 slot intended for a secondary graphics card.

● Install full-length cards in slots that support full-length cards.

● For optimal cooling and acoustics do not insert a card next to a graphics card to avoid blocking the
graphics card heatsink and fan. This is especially important for a card that requires an auxiliary
power cable. For best results, choose a lower profile card to place next to the heatsink and fan.

● Install a card in a slot that most closely matches its interface technology:

◦ Install a PCIe Gen2 x8 card in a PCIe Gen2 x8 slot.

◦ Install a PCIe Gen1 x8 card in a PCIe Gen1 x8 slot.

◦ Install a PCIe Gen1 x4 card in a PCIe Gen1 x4 slot.

◦ Install a PCIe Gen1 x1 card in a PCIe Gen1 x1 slot.

◦ Install a PCI card in a PCI slot.

◦ Whenever possible, install a PCIe x1 card in an x1 slot.

● Leave as much space as possible between cards.

● For best operational efficiency, select a slot that:

◦ Electrically matches the number of PCIe card lanes (e.g., x4 in a x4 slot).

◦ Has more lanes electrically.

◦ Has fewer lanes, but is closer to your needs. For example, place an x16 card in an x8 slot,
and an x8 card in a an x4 slot.

● An x1 connector supports an x1 card only. Although, an x1 card can be inserted into any slot, this
may waste the potential for future card placement.

● Install cards that require internal cable connections so that the cables are organized and have the
least amount of strain on them. Some cables may be routed under, rather than over the other
expansion cards.

● To prevent electromagnetic interference, avoid installing a card with external cable connections
next to a graphics card.
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Expansion card
NOTE: Read Warnings and cautions on page 59 before servicing this component.

PCIe I/O slots can support other PCIe cards with less bus bandwidth than what is physically defined for
the slot.

Expansion card slot description
NOTE: The x1, x4, x8, and x16 designators describe the number of signals that an expansion card,
or an expansion card slot, can accommodate. For example, x4(x8) means that a card designed to
receive four signals electrically can be placed in a slot designed for an eight-signal card.

Use the following table to determine PCIe card compatibility.

Table 5-6  Workstation PCIe compatibility matrix

Slot Mechanical compatibility Electrical compatibility

1 x8 connector, open-ended PCIe2 (x4)

2 x16 connector PCIe2 (x1, x4, x8, x16)

3 x8 connector, open-ended* PCIe (x4)

4 x16 connector PCIe2 (x1, x4, x8, x16)

* This slot is open-ended so a PCIe x16 card can be inserted.

Slots one, two, and four are PCIe GEN2 slots.

Graphics cards greater than 75 watts require the use of an auxiliary power cable adapter.

Removing an expansion card
To remove an expansion card:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).
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3. Remove the expansion card support (if installed) by removing the two screws and lifting up on the
support.

Figure 5-24  Removing expansion card support

4. Remove all cables connected to the expansion card.

5. Push down on the expansion card retention clamp levers on the inside of the chassis to open the
retention clamp  as shown below.

Figure 5-25  Removing the expansion card

Release the expansion card slot latch 2, and then carefully lift the card from the chassis .

6. Install a expansion slot cover and close the expansion card retention clamp.

If the expansion card retention clamp does not close, ensure that all cards are properly seated,
and then try again.
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Installing an expansion card
Visit http://www.hp.com/go/quickspecs to learn which graphics cards are supported in the workstation,
how much memory each graphics card includes, and graphics card power requirements.

To install an expansion card:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Push the expansion card retention clamp levers down on the outside of the chassis to release the
retention clamp  as shown in the figure below.

Figure 5-26  Removing the slot cover

4. Remove the expansion card slot cover by pulling it up, out of the chassis 2.

TIP: Grasp the slot cover between two fingers—one from the inside of the chassis, and one from
the outside.

5. Angle the card into the expansion card guide.

6. Align the PCIe card keyway with the slot key, and then firmly seat the card in the slot as shown
next .

7. Close the expansion card retention clamp by rotating it downward .

If the PCI retention clamp does not close, ensure that all cards are properly seated, and then try
again.

If required by the card, connect the auxiliary power cable to the card (not illustrated).
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Battery
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install the battery.

The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.

WARNING!  This workstation includes a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 60°C (140°F).

CAUTION: Before removing the battery, back up the CMOS settings in case they are lost when the
battery is removed. To back up the CMOS settings, select the Save to Diskette option in the Computer
Setup (F10) Utility.

NOTE: Do not dispose of batteries, battery packs, and accumulators with general household waste.

Removing the battery
To remove the battery:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. On the system board, press the release tab of the battery holder.

4. Pull the tab  on the battery holder, and then lift it straight up 2 as shown in the following figure.

Installing the battery
To install the battery:

1. Confirm the polarity (positive or negative) of the battery to position it correctly in the battery holder.

2. Place the battery edge under the plastic housing tab and press gently until it snaps into place.
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Hard disk drive
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section provides information to successfully remove and install a hard disk drive.

Removing the hard disk drive
To remove a hard disk drive:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Disconnect the power and data cables from the drive.

4. Press the green hard disk drive release tab , then slide the hard disk drive 2 from the chassis
as shown.

Figure 5-27  Removing the drive from the chassis

5. Replace the side access cover when finished.

Installing the hard disk drive

Installation guidelines

The workstation typically ships with an HDD, but additional drives can be added to expand data storage:

● Refer to the service label on the side access panel of your workstation to determine the location
of the SAS and SATA ports.

● Additional HDDs must be added in a specific sequence, depending on the type of workstation.

● Once installed, the HDDs are assigned drive letters, with C:\ being the typical boot disk. Drive letters
are assigned using the Computer Setup (F10) Utility.
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● With additional HDDs installed, the workstation boot sequence can be modified so that the
workstation boots from one of the additional drives. Boot sequence is specified using the Computer
Setup (F10) Utility.

● With additional HDDs installed, you have hard disk space for additional programs, data files, and
backup.

The HDD bays are not labeled on the chassis. 

The cables plug into the system board connectors in the following manner:

● SATA HDD cables are plugged into SATA ports, starting at SATA port zero.

● SAS HDD cables do not plug into system board connectors, but into a separate SAS controller
card.

Installation

To install an HDD:

1. Select a drive bay in which to install the hard disk drive.

2. Locate the four isolation grommet screws on the chassis.

3. Install the four isolation grommet screws as shown in the following figure.

Figure 5-28  Installing the grommet screws
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4. If installing a SAS drive, attach a SAS-to-SATA cable adapter to the connector on the SAS hard
drive as shown in the following figure.

NOTE: SAS Drives require a separate SAS Controller plug-in card.

Figure 5-29  Attaching the cable adapter

5. Push the hard disk drive into the selected bay until it snaps into place  as shown in the following
figure.

Figure 5-30  Installing the HDD drive

6. Attach a power cable 2 to the drive, and attach a data cable  from the SATA port or SAS controller
to the hard disk drive.

NOTE:  For SATA and SAS HDDs, connect data cables to lower-numbered drive connectors first
on the system board (for SATA HDDs) or SAS controller card (for SAS HDDs). To identify hard
disk drive connectors, refer to the workstation service label on the side access panel.
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7. Replace all components that were removed in preparation for component installation.
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CPU heatsink
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install a CPU heatsink.

Removing the CPU heatsink
To remove a heatsink:

1. Power down the workstation (see Predisassembly procedures on page 66).

2. Disconnect power from the workstation (see Predisassembly procedures on page 66).

3. Remove the side access panel (see Removing the side access panel on page 69).

4. Slowly and evenly loosen one pair of diagonally opposite screws  from the CPU until the screw
shanks disengage from the system board, and then loosen the remaining pair 2 as shown below.

CAUTION: Do not fully loosen one screw, and then move on to the next. Instead, loosen all
screws a little at a time, ensuring that the CPU remains level.

Figure 5-31  Loosening heatsink screws in sequence
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5. Disconnect the CPU heatsink fan cable  from the system board  as shown in the following figure.

Figure 5-32  Disconnecting the heatsink fan cable

6. Before lifting the heatsink, gently twist the heatsink to break the thermal compound between the
CPU and the heatsink.

7. Lift the CPU heatsink out of the chassis 2.

8. Use alcohol and a soft cloth to clean the thermal interface residue from the CPU and the heatsink,
allowing the alcohol on the CPU and CPU heatsink to dry completely.

Installing the CPU heatsink
To install a heatsink:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the CPU heatsink (see Removing the CPU heatsink on page 101).

4. Perform one of the following tasks:

● If you are reusing the original heatsink, apply thermal compound to the center of the CPU top
surface.

● If you are using a new CPU heatsink, do not apply thermal compound to the CPU because
the new heatsink already has thermal compound applied to the heatsink surface. Instead,
remove the thermal compound protective liner from the bottom of the new heatsink.

5. Align the four mounting screws with the mounting holes in the system board and carefully place
the heatsink on the CPU.

Ensure that the heatsink is placed properly with the fan positioned toward the front, facing the
memory DIMMs.

CAUTION: Do not overtighten the heatsink screws. If you overtighten them, you might strip the
threads in the system board tray.

Do not fully tighten one screw and then move on to the next. Instead, tighten all screws a little at
a time, ensuring that the CPU remains level.
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6. Tighten all screws partially so the CPU heatsink remains level.

7. Tighten each set of diagonally opposed screws a little at a time to 6 in.-lbs. of torque.

8. Connect the CPU heatsink fan connector to the system board.

Figure 5-33  Connecting the heatsink fan cable

ENWW Removing and installing components 103



CPU
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes how to remove and install a CPU.

Removing a CPU
To remove a CPU:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the CPU heatsink (see Removing the CPU heatsink on page 101).

4. Raise the CPU socket lever  and open the cover 2 as shown in the following figure.

CAUTION: Do not touch the CPU socket contacts or the gold pads underneath the CPU. Use
extreme care and handle the CPU only by the edges.

5. Pull the CPU straight out of the socket , and store the CPU in a static free container in a safe
place where it cannot be damaged
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Installing a CPU
NOTE: HP recommends that you do not swap processors (CPUs) from one system board to another.

To install a CPU:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove the CPU heatsink (see Removing the CPU heatsink on page 101).

4. Remove the CPU (see Removing a CPU on page 104).

5. Using extreme care, fully raise the CPU socket lever and cover.

CAUTION: The CPU socket contacts are delicate. To avoid bending the contacts, use extreme
care when installing the CPU in the socket.

6. Align the notches in the CPU base with the tabs on the socket as shown in the figure below.

Seat the CPU into the socket. Ensure that the underside of the CPU is level with the top of the CPU
socket.

7. Close the CPU cover plate by lightly pressing down on the CPU cover plate while closing the socket
lever.

8. Replace the CPU heatsink (see Installing the CPU heatsink on page 102), and then close the side
access cover.
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System board
NOTE: Read Warnings and cautions on page 59 before servicing this component.

This section describes replacing the system board.

Removing the system board
To remove the system board:

1. Disconnect power from the workstation (see Predisassembly procedures on page 66).

2. Remove the side access panel (see Removing the side access panel on page 69).

3. Remove expansion boards and graphics cards (see Removing an expansion card on page 93),
and then remove the CPU heatsink (see Removing the CPU heatsink on page 101).

TIP: Make a note of the cable connections before disconnecting them from the system board.
For more information, refer to Power connectionson page 83.

4. Disconnect all cabling from the system board.

5. Gently squeeze the release mechanism  as shown in the following figure.

Figure 5-34  Removing the system board

6. Lift the system board slightly to clear the release mechanism and then pull the board away from
the rear of the chassis and then lift the system board upward 2 out of the chassis.

Installing the system board
To install the system board:

1. Insert the system board with the rear chassis side of the board tilted slightly downward.

2. Push back on the board while maintaining downward pressure on the board to clear the release
mechanism. The latch should click into place.

3. Reinstall all removed components and cables. (Refer to Power connections on page 83 to identify
power cables.)
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Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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6 Diagnostics and troubleshooting

This chapter describes the tools available for diagnosing and troubleshooting system issues, and
includes these topics:

Topics

Calling technical support on page 109

Locating ID labels on page 109

Locating warranty information on page 110

Diagnosis guidelines on page 111

Troubleshooting checklist on page 113

HP troubleshooting resources and tools on page 114

Troubleshooting scenarios and solutions on page 116

Self-troubleshooting with HP Vision Field Diagnostics on page 126

Diagnostic codes and errors on page 134

108 Chapter 6   Diagnostics and troubleshooting ENWW



Calling technical support
At times you might encounter an issue that requires technical support. When you call technical support:

● Have the workstation readily accessible.

● Write down the workstation serial numbers, product numbers, model names, and model numbers
and have them in front of you.

● Note any applicable error messages.

● Note any add-on options.

● Note the operating system.

● Note any third-party hardware or software.

● Note the details of any blinking LEDs on the front of the workstation.

● Note the applications you were using when you encountered the problem.

● Note the power supply BIST status, if applicable.

NOTE: When calling in for service or support, you might be asked for the Product Number (example:
PS988AV) of the workstation. If the workstation has a Product Number, it is generally located next to
the 10- or 12-digit Serial Number of the workstation.

NOTE: On most models, the serial number and product number labels can be found on the top panel
or side of the workstation and at the rear of the workstation.

For a listing of all worldwide technical support phone numbers, visit http://www.hp.com/support, select
your region, and click Contact HP in the upper-left corner.

Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each
workstation.
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Each HP Workstation has two unique serial number labels  and a Certificate of Authentication (COA)
label 2 as shown in the figure below.

Figure 6-1  Workstation label locations

In general, the serial number labels can be found on the top panel or on the side of the workstation and
at the rear of the workstation (your workstation may look different). Keep this number available when
contacting customer service for assistance.

A product number is generally located next to the serial number.

The COA is used for Windows-preinstalled systems only, and is generally located on the top panel or
side of the workstation near the serial number label. On some workstations it is located on the bottom
of the workstation.

Locating warranty information
To locate base warranty information, visit http://www.hp.com/support/warranty-lookuptool or refer to
the Documentation and Diagnostics CD that shipped with your workstation.

To locate an existing Care Pack, visit http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack Services
offer upgraded service levels to extend and expand a standard product warranty.
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Diagnosis guidelines
If you encounter a problem with the workstation, monitor, or software, the following sections provide a
list of general suggestions that help you isolate and focus on the problem before taking further action.

Diagnosis at startup
● Verify that the workstation and monitor are plugged into a working electrical outlet.

● Remove all diskettes, CDs, or USB drive keys from your system before turning it on.

● Verify that the workstation is turned on and the green power light is on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the monitor is turned on and the green monitor light is on. Note that not all monitors are
equipped with LED lights to indicate their functionality.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the primary display adapter. During startup, the other monitor connectors are
disabled; if the monitor is connected to one of these ports, it will not function after Power-on Self
Test (POST). You can select the default VGA source in Computer Setup (F10).
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Diagnosis during operation
● Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will

help you diagnose the problem. Refer to the Diagnostic LED and audible (beep) codes
on page 134 section of this document for information on interpreting diagnostic lights and audible
codes.

● Press and hold any key. If the system beeps, then your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option.

● Be sure that all required device drivers have been installed. For example, if you have connected
a printer, you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

● If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

● If the screen is blank, plug the monitor into a different video port on the workstation if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new features
or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals.
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Troubleshooting checklist
Before running diagnostic utilities, use the following checklist to find possible solutions for workstation
or software problems.

● Is the workstation and monitor connected to a working electrical outlet?

● Is the workstation powered on?

● Is the green power light illuminated?

● Is the monitor on?

● Is the green monitor light illuminated?

● If the monitor is dim, adjust the monitor brightness and contrast controls.

● Press and hold any key. If the system beeps, the keyboard is operating correctly.

● Check cables for loose or improper connections.

● After installing a non-plug and play (PnP) expansion board or other option (such as a diskette drive),
reconfigure the workstation.

● Are all necessary device drivers installed?

● Have all printer drivers been installed for each application?

● Have you removed diskettes, optical disks, and USB drive keys from the drives before powering
on the workstation?

● Are you running the latest version of BIOS, drivers, and software?
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HP troubleshooting resources and tools
This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for
troubleshooting.

HP Help and Support Center
The HP Help and Support Center is a customized HP user interface that enhances the Windows XP
Help and Support Center Help feature. This customized utility allows you to access specific information
about your HP Workstation such as configuration information by clicking Start > Help and Support
Center. The interface also provides customized help and support links to the HP Web site related to
your HP Workstation.

NOTE: The customized HP Help and Support Center is not available on Windows XP Professional
x64 Edition or on Linux.

NOTE: Currently, HP Help and Support Center does not work on Windows Vista.

E-support
Online access and support resources include Web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following Web sites are also available to you:

● http://www.hp.com—Provides useful product information.

● http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

● http://www.hp.com/go/workstationsupport—Provides technical support information for
workstations.

● http://www.hp.com/support—Provides a listing of the worldwide technical support phone numbers.
Access the telephone numbers by visiting the Web site, then select your region, and click Contact
HP in the upper-left corner.

● http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.

Troubleshooting a problem
To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to the workstation series and
model, and to the problem you are troubleshooting.

Instant Support and Active Chat
HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.

114 Chapter 6   Diagnostics and troubleshooting ENWW

http://www.hp.com
http://www.hp.com/support/workstation_manuals
http://www.hp.com/go/workstationsupport
http://www.hp.com/support
http://www.hp.com/support/workstation_swdrivers
http://www.hp.com/go/workstationsupport


Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit
a support ticket, Active Chat collects information about the computer and pass it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, visit
http://www.hp.com/hps/hardware/hw_professional.html.

NOTE: This feature is not available on Windows XP Professional x64 Edition or on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices
To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Under Resources for <your selected product>, select See more….

4. Under Self-Help resources: in the center of the window, choose the desired action and appropriate
information in the scroll list to view the index.

Product Change Notifications
Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30-60 day window of the effective date of the change in the manufacturing process. PCNs give
customers advanced notice of changes to their product, such as an updated BIOS version that they may
need to qualify prior to the change taking place. The latest PCNs are located at: http://www.hp.com/go/
workstationsupport.

Helpful hints
If you encounter a problem with the workstation, monitor, or software, the following provides a list of
general suggestions that help you isolate and focus on the problem before taking further action.

At startup
● Verify that the workstation and monitor are plugged into a working electrical outlet.

● Remove all diskettes, optical disks, and USB drive keys from the drives before powering on the
workstation.

● Verify that the workstation is turned on and the green power light is on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the monitor is turned on and the green monitor light is on.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).
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During operation

● Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will
help you diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section of
this document for information on interpreting diagnostic lights and audible codes.

● Press and hold any key. If the system beeps, then your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected
a printer, you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

● If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

● If the screen is blank, plug the monitor into a different video port on the workstation if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new features
or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Service and Technical
Reference Guide at http://www.hp.com/support/workstation_manuals.

Customizing the monitor display
You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings. To do so, right-click the desktop, then click Properties to
change display settings. For more information, see the online documentation provided with the graphics
controller utility or the documentation that came with your monitor.

Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and possible solutions
for a Windows-based workstation.

NOTE: For Linux troubleshooting information, refer to the HP Workstations for Linux User Manual
at http://www.hp.com/support/linux_user_manual.
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Solving minor problems
Table 6-1  Minor problems

Problem Cause Possible Solution

Workstation appears frozen
and does not shut down when
the power button is pressed.

Software control of the power
switch is not functional.

1. Press and hold the power button for at least four
seconds until the workstation shuts down.

2. Disconnect the electrical plug from the outlet.

3. Restart the workstation.

Workstation seems to be
frozen.

Program in use has stopped
responding to commands.

1. If possible, use the Windows Task Manager to isolate
and terminate the offending process.

2. Attempt the normal Windows shutdown procedure.

3. Restart the workstation using the power button.

Workstation date and time
display is incorrect.

Real-time clock (RTC) battery
might need replacement.

1. Reset the date and time in the Control Panel.

2. Replace the RTC battery.

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use the Computer Setup
(F10) Utility or the Microsoft Windows Device Manager to
disable the network controller.

Cursor does not move using
the arrow keys on the keypad.

The Num Lock key might be on. Press Num Lock. The Num Lock key can be disabled or
enabled in the Computer Setup (F10) Utility.

Poor performance is
experienced.

Processor is hot. 1. Verify that airflow to the workstation is not blocked.

2. Verify that chassis fans are connected and working
properly. Some fans operate only when needed.

3. Verify that the processor heatsink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.
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Problem Cause Possible Solution

Workstation powered off
automatically and the Power
LED flashes red 2 times (once
every second), followed by a 2-
second pause, and then two
simultaneous beeps sounded.

Processor thermal protection is
activated.

A fan might be blocked or not
turning.

OR

The processor heatsink is not
properly attached to
the processor.

1. Verify that the workstation air vents are not blocked.

2. Open the access panel and press the workstation
power button.

3. Verify that the system fan is running.

4. Verify that the processor heatsink fan spins. If the fan
is not spinning, verify that the heatsink fan cable is
plugged into the system board connector and that the
heatsink is properly seated.

5. Replace the processor heatsink.

System does not power on,
and the LEDs on the front of
the workstation are not
flashing.

System cannot power on. Press and hold the power button for less than four seconds.
If the hard drive LED turns green, then perform the following
steps.

1. To find a faulty device, remove all devices one at a time:

a. Disconnect AC power to the workstation.

b. Remove a device.

c. Reconnect AC power and power on the
workstation.

2. Repeat this process until the faulty device is identified.
Remove the graphics card last. Replace the faulty
device.

3. If no faulty device is found, replace the system board.

OR

1. Press and hold the power button for less than four
seconds. If the hard drive LED does not illuminate, then
perform the following tasks:

a. Verify that the workstation is plugged into a
working AC outlet.

b. Verify that the power button harness is connected
to the inline front panel I/O device assembly
connector.

2. Verify that the power supply cables are connected to
the system board.

3. Verify power supply functionality:

a. Disconnect the AC power.

b. Remove the internal power supply cables from
system board (you do not need to remove power
supply from chassis).

c. Reconnect the AC power.

● If the power supply fan spins and the BIST
LED illuminates (see Testing power supply
on page 119), the power supply is good.
Replace the system board.

● If the power supply fan does not spin or the
LED does not illuminate (see Testing power
supply on page 119), replace the power
supply.

Table 6-1  Minor problems (continued)
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Solving power supply problems
This section presents power supply troubleshooting scenarios.

Testing power supply
Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply
still works.

To test the power supply:

1. Unplug the AC power.

2. Remove the internal power supply cables from system board (you do not need to remove power
supply from chassis).

3. Plug in AC power and verify the following:

● If the green BIST LED on the rear of the workstation is illuminated and the fan is spinning, the
power supply is functional.

● If the green BIST LED is not illuminated or the fan is not spinning, replace the power supply.

See the Rear panel components section of this service guide to locate the BIST LED on this workstation.

Table 6-2  Power supply problems

Problem Cause Solution

Power supply shuts down
intermittently.

Power supply fault. Replace the power supply.

Workstation powers off and the
Power LED flashes red 2 times
(once every second), followed by a
2-second pause.

Processor thermal protection
is activated.

A fan might be blocked or not
turning.

OR

The processor heatsink fan
assembly is not properly
attached to the processor.

1. Ensure that the workstation air vents are not blocked.

2. Open the access panel and press the workstation
power button.

3. Verify that the system fan is running.

4. Verify that the processor heatsink fan spins.

If the heatsink fan is not spinning, verify that the fan
cable is plugged into the system board connector.
Verify that the fan is properly seated.

5. Replace the processor heatsink.

Power LED flashes red (once every
2 seconds).

Power failure (power supply is
overloaded).

1. Determine whether a device is causing the problem
by performing the following:

a. Disconnect AC power.

b. Remove all attached devices.

c. Power on the workstation.

If the system enters the POST, perform the following:

a. Power off the workstation.

b. Replace one device at a time and repeat this
procedure until a failure occurs.
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Problem Cause Solution

c. Replace the device causing the failure

d. Continue adding devices one at a time to verify
that all devices are functioning.

2. Verify power supply functionality.

a. Disconnect AC power.

b. Remove the internal power supply cables from
system board (you do not need to remove power
supply from chassis).

c. Plug in AC power.

● If the power supply fan spins and the LED
illuminates (see Testing power supply
on page 119), the power supply is good.
Replace the system board.

● If the power supply fan does not spin or the
LED does not illuminate (see Testing
power supply on page 119), replace the
power supply.

Solving diskette problems
Table 6-3  Diskette problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. 1. Right-click Start, select Explore, and then select a
drive.

2. Select File>Properties>Tools.

3. Under Error-checking, select Check Now.

Diskette is incorrectly inserted. Remove and reinsert diskette.

Files on the diskette are
damaged.

Verify the program diskettes.

Drive cable is not properly
connected.

Reconnect the power cable and verify that all four pins
are connected.

Drive not found. Cable is loose. Reseat the diskette drive data and power cables.

Removable drive is not seated
properly.

Reseat the drive.

Diskette drive cannot write to a
diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.

Writing to the wrong drive. Verify the drive letter in the path statement.

There is not enough space on
the diskette.

Use another diskette.

Diskette write-control is
enabled.

Use the Computer Setup (F10) Utility to verify the storage
security feature disabled settings.

Diskette is damaged. Replace the damaged disk.

Table 6-2  Power supply problems (continued)
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Problem Cause Solution

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, you might need to
specify diskette capacity.

For example, to format a 1.44-MB diskette, enter the
following command at the MS-DOS prompt: FORMAT
A: /F:1440

A problem has occurred with a disk
transaction.

The directory structure is bad,
or there is a problem with a file.

1. Right-click Start, select Explore, and then select a
drive.

2. Select File>Properties>Tools.

3. Under Error-checking, select Check Now.

Diskette drive cannot read
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong
diskette type for the drive type.

Verify the type of drive that you are using and use the
correct diskette type.

You are reading the wrong
drive.

Verify the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

Invalid system disk is displayed. A diskette that does not contain
the system files needed to start
the workstation has been
inserted into the drive.

When drive activity stops, remove the diskette and press
the Spacebar. The workstation attempts to boot from the
next device in the boot order.

Diskette error has occurred. Restart the workstation by pressing the power button.

Cannot boot to diskette Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been
disabled in Computer Setup.

Run the Computer Setup (F10) Utility and enable diskette
boot in Storage>Boot Order.

Removable media boot has
been disabled in Computer
Setup.

Run the Computer Setup (F10) Utility and enable
Removable Media Boot in Storage>Storage Options.

Diskette MBR validation is
enabled.

Run the Computer Setup (F10) Utility and disable
Diskette MBR Validation in Storage>Storage Options.

Solving hard drive problems
Table 6-4  Hard drive problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad sectors or
has failed.

Locate and block the usage of bad sectors. If necessary,
reformat the hard disk.

If the drive is detected by the BIOS, run DPS Self-test.

Disk transaction problem. The directory structure is bad,
or there is a problem with a file.

1. Right-click Start, select Explore, and select a drive.

2. Select File>Properties>Tools.

3. Under Error-checking, select Check Now.

Table 6-3  Diskette problems (continued)
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Problem Cause Solution

Drive not found (identified). Improper cable connection On workstations with discreet data and power cables,
ensure that the data and power cables are securely
connected to the hard drive. (See the Hard drive section of
this guide for connection details.)

Improperly seated hard drive On systems with blind-mate drive connections, check for
connector damage on the drive and in the chassis.

Reseat the hard drive and its carrier in the chassis to
ensure a proper connection. (See the Hard drive section of
this guide for connection details.)

The system might not have
automatically recognized a
newly installed device.

1. Run the Computer Setup (F10) Utility.

2. If the system does not recognize the new device,
verify that the device is listed in the Computer Setup
(F10) Utility.

If it is listed, the probable cause is a driver problem. If
it is not listed, the probable cause is a hardware
problem.

3. If this drive is newly installed, enter Setup and try
adding a POST delay under Advanced>Power-On.

Drive responds slowly
immediately after power-up.

Run the Computer Setup (F10) utility, and increase the
POST Delay in Advanced>Power-On Options.

Nonsystem disk or NTLDR missing
message.

System is trying to start from a
nonbootable diskette.

Remove the diskette from the drive.

System is trying to start from a
damaged hard drive.

1. Insert a bootable diskette into the drive and restart the
workstation.

2. If the hard drive is still inaccessible and MBR Security
is enabled, try restoring the previously saved
MBR image by entering Setup and selecting
Security>Restore Master Boot Record.

System files missing or not
properly installed.

1. Insert a bootable system diskette and restart.

2. Verify that the hard drive is partitioned and formatted.

3. Install the system files for the appropriate operating
system, if necessary.

Hard drive boot disabled in
Computer Setup.

Run the Computer Setup (F10) Utility and enable the hard
drive entry in the Storage>Boot Order list.

Workstation will not start. Hard drive is damaged. Replace the hard drive.

Table 6-4  Hard drive problems (continued)
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Solving display problems
Table 6-5  Display problems

Problem Cause Solution

Blank screen (no video). The cable connections are not
correct.

Verify the cable connections from the monitor to the
workstation and to a working electrical outlet.

The monitor is off. Turn the monitor on (LED is on). You might need to refer
to the monitor manual for an explanation of LED signals.

Screen blanking utility installed
or energy saver features
enabled.

Press a key or the mouse button and, if set, enter your
password.

System ROM is bad; system is
running in FailSafe Boot Block
mode (indicated by 8 beeps).

Reflash the ROM using a SoftPaq.

Fixed-sync monitor does not
sync at the resolution
specified.

Verify that the monitor can accept the same horizontal scan
rate as the resolution specified.

Computer is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Workstation monitor settings
are not compatible with the
monitor.

1. When you see Press F8 in the bottom-right corner of
the screen, restart the workstation and press F8
during startup.

2. Using the keyboard arrow keys, select Enable VGA
Mode and then press Enter.

3. For Windows, double-click the Display icon in the
Control Panel and then select the Settings tab.

4. Use the sliding control to reset the resolution.

The display works properly during
the POST but goes blank when the
operating system starts.

The display settings in the
operating system are
incompatible with your
graphics card and monitor.

1. For Windows, restart your workstation in VGA mode.

2. After the operating system starts, change the display
settings to match those supported by your graphics
card and monitor.

3. Refer to your operating system and graphics card
documentation for information about changing display
settings.

Power LED flashes red 6 times
(once every second), followed by a
2–second pause, and then the
workstation beeps 6 times.

Prevideo graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

Monitor does not function when
used with Energy Saver features.

Monitor without Energy Saver
capabilities is being used with
Energy Saver features
enabled.

Disable the monitor Energy Saver feature.

Dim characters The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is connected to the graphics
card and the monitor.
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Problem Cause Solution

Blurry video or requested
resolution cannot be set.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit, or
download and install the latest drivers for your graphics
card from http://welcome.hp.com/country/us/en/
support.html.

Monitor cannot display
requested resolution.

Change the requested resolution.

The picture is broken up, rolls,
jitters, or flashes.

The monitor connections might
be faulty, or the monitor might
be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
workstation.

2. In a multiple CRT monitor system, ensure that the
monitors' electromagnetic fields are not interfering
with each other . Move them apart if necessary.

3. Move fluorescent lights or fans that are too close to
the CRT monitor.

Monitor must be degaussed. Degauss the monitor.

Vibrating or rattling noise coming
from inside a CRT monitor when
powered on.

Monitor degaussing coil has
been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a
CRT monitor.

Electronic relays have been
activated inside the monitor.

None. It is normal for some monitors to make a clicking
noise when turned on and off, when going in and out of
Standby mode, and when changing resolutions.

High pitched noise coming from
inside a flat-panel monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting,
or shadowing effects; horizontal
scrolling lines; faint vertical bars; or
unable to center the picture on the
screen (flat-panel monitors using
an analog VGA input connection
only.)

Flat-panel monitor’s internal
digital conversion circuits
might be unable to correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s onscreen display menu.

2. Manually synchronize the Clock and Clock Phase
onscreen display functions.

3. Download SoftPaq SP22333 to assist with the
synchronization).

Some typed symbols do not appear
correctly.

The font you are using does
not support that symbol.

Use the Character Map to locate and select the appropriate
symbol.

Select Start>All Programs> Accessories>System
Tools>Character Map. You can copy the symbol from the
Character Map into a document.

Table 6-5  Display problems (continued)
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Solving audio problems
Table 6-6  Audio problems

Problem Cause Solution

Sound does not come out of the
speaker or headphones.

Software volume control is
turned down.

Double-click the Speaker icon on the taskbar and use the
volume slider to adjust the volume.

The external speakers are not
turned on.

Turn on the external speakers.

External speakers plugged into
the wrong audio jack.

See your sound card documentation for proper speaker
connection.

Digital CD audio is
not enabled.

Enable digital CD audio:

1. From the Control Panel, select System.

2. On the Hardware tab, select the Device Manager
button.

3. Right-click the CD/DVD device and select
Properties.

4. On the Properties tab, select Enable digital CD audio
for this CD-ROM device.

Headphones or devices
connected to the line-out
connector have muted the
internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external
speakers.

Volume is muted. 1. From the Control Panel, select Sound, Speech and
Audio Devices, and then select Sounds and Audio
Devices.

2. Deselect the Mute checkbox.

Computer is in Standby mode. Press the power button to resume from Standby mode.

Noise or no sound comes out of the
speakers or headphones.

1. If you are using digital speakers that have a stereo
jack and you want the system to autoswitch to digital,
use a stereo-to-mono adapter to engage the auto
sense feature, or use multimedia device properties
to switch the audio signal from analog to digital.

2. If the headphones have a mono jack, use the
multimedia device properties to switch the system to
analog out.

NOTE: If you set digital as the Output Mode, the
internal speaker and external analog speakers no
longer output audio until you switch back to an auto
sense or analog mode.

If you set analog as the Output Mode, external digital
speakers do not function until you change the output
mode back to an auto-sense or digital mode.

Sound occurs intermittently. Processor resources are being
used by other open
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked
up while recording audio.

The hard disk might be full. 1. Before recording, be sure there is enough free space
on the hard disk.

2. Try recording the audio file in a compressed format.
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Solving printer problems
Table 6-7  Printer problems

Problem Cause Solution

Printer does not print. Printer is not turned on and
online.

Turn the printer on and be sure it is online.

The correct printer driver for
the application is not installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\> [printer port]

Replace printer port with the address of the printer
used. If the printer works, reload the printer driver.

If you are on a network, you
might not have made a
connection to the printer.

Make the proper network connection to the printer.

Printer might have failed. Run printer self-test.

Printer does not turn on. The cables might not be
connected properly.

 

Self-troubleshooting with HP Vision Field Diagnostics
Hewlett-Packard Vision Field Diagnostics is a diagnostic tool that can be used by the end user or
technical support personnel to view information about the hardware configuration of the computer and
perform hardware troubleshooting on HP Desktop and Workstation systems. This diagnostic tool should
be used to help determine hardware failures. Accessible by either CD or USB key, these diagnostics
run outside the operating system and so make it easy to isolate potential issues that may be operating
system related versus hardware.

HP Vision Field Diagnostics benefits are:

● Capture complete system configuration information that can be shared as an HTML file, including:

◦ System serial number

◦ System product number

◦ System BIOS revision

◦ Memory size and configuration

◦ Processor information

◦ Storage device information and configuration

◦ Graphics / audio / communications information and configuration

◦ And more...

● Comprehensive list of diagnostic test available with new added features:

◦ Highly configurable testing options: quick / complete / custom / interactive / non-interactive

◦ Specific failing memory DIMM identification

◦ Tests video card memory
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◦ Launches DST Smart tests for both SATA and SAS drives

◦ Many other tests and diagnostics

● Warranty Code output – A unique warranty code is generated for each failure which can be used
to validate diagnostic use for a specific system

● Easy to use - uses similar user interface as previous field diagnostics, HP Insight Diagnostics

● True End2End diagnostics – same diagnostics modules used in factory

● Easy to obtain

◦ Download from Web

◦ USB key bootable or CD bootable

◦ Included with restore media

It is expected that these Vision diagnostics will be run on supported products when attempting to
troubleshoot system issues.

Overview
The HP Vision Field Diagnostics utility allows you to view information about the hardware configuration
of the workstation and perform hardware diagnostic tests on the subsystems of the workstation. The
utility simplifies the process of effectively identifying, diagnosing, and isolating hardware issues.

The Survey tab is displayed when you invoke HP Vision Field Diagnostics. This tab shows the current
configuration of the workstation. From the Survey tab, there is access to several categories of
information about the workstation. Other tabs provide additional information, including diagnostic test
options and test results. The information in each screen of the utility can be saved as an html file and
stored on a diskette or USB flash drive.

Use HP Vision Field Diagnostics to determine if all the devices installed on the workstation are
recognized by the system and functioning properly. Running tests is optional but recommended after
installing or connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

NOTE: Third-party devices may not be detected by HP Vision Field Diagnostics.

Downloading and accessing HP Vision Field Diagnostics
To access HP Vision Field Diagnostics the utility has to be downloaded from the HP Web site and copied
to CD or USB drive.

1. Go to http://www.hp.com.

2. Select the Support & Drivers link.

3. Select the Download driver and software radio button.

4. Enter your product number (for example, 800) in the text box, and then press Enter.

5. Select your operating system.

6. Select the Diagnostic link.

7. Locate HP Vision Field Diagnostics and select Download.
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8. After the .iso file is downloaded, use CD-ROM burning software to copy the .iso file to an optical
medium or USB flash drive.

9. When the CD or USB flash drive has the utility installed, insert the CD or USB flash drive into the
workstation (while it is on).

10. Shut down the operating system and turn off the workstation.

11. Turn on the workstation. The system will boot into HP Vision Field Diagnostics.

NOTE: If the system does not boot to the CD in the optical drive or to the USB flash drive, you
may need to change the boot order in the Computer Setup (F10) utility.

12. At the boot menu, select either the HP Vision Field Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-
alone application, outside of HP Vision Field Diagnostics.

13. If running HP Vision Field Diagnostics, select the appropriate language and click Continue.

14. In the End User License Agreement page, select Agree if you agree with the terms. The HP Vision
Field Diagnostics utility launches with the Survey tab displayed

User interface
The HP Vision Field Diagnostics application provides six major functions, accessible through Tabs.
These functions are:

● Survey — Your current system hardware information.

● Test — List all diagnostics available for your system. Tests are started there.

● Status — This screen shows progress and status of currently running diagnostics.

● History — All past diagnostics runs and status are listed there.

● Errors — All past diagnostics failures are listed there.

● Help — User help about HP Vision Diagnostics.

There are also some common operations that are part of the utility. They include:

● Exit Diagnostics button — This button will close HP Vision Diagnostic application and reboot your
system. Any running test will be aborted.

● Reload button — If available, this button will rescan your system hardware and reload the
diagnostics without the need to restart your entire system.

● Save button — If available, save your system survey, test history or error data as an HTML file to
a floppy disk or a USB key drive.

Survey tab
The Survey tab shows your system hardware information, organized into eleven Categories (for example
"Processors") and device instances (for example "Processor 1").

The amount of information displayed can be controlled by selecting a combination of View Level and
Category.
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The View Levels include:

● Overview — shows high level summary of the system hardware. This is the default view level.

● Summary — gives limited configuration data for each specific Category.

● Advanced — offers more technical and low-level data for the computer-savvy user.

The Categories Levels include:

● All — Shows all Categories.

● Architecture — Shows system architecture information such as high level PCI devices, low level
SMBIOS, CMOS and PCI configuration space data.

● Audio — Shows all embedded and add-on audio devices.

● Asset Control — Shows asset control related information such as product name, serial number,
asset tag, and universal unique ID information.

● Communication — Shows communication devices such as serial, parallel, USB, network,
Firewire, modem, and Bluetooth ports and devices.

● Graphics — Shows all embedded and add-on video cards.

● Input Devices — Shows user input devices such as all connected mice and keyboards.

● Memory — Shows system memory information.

● Miscellaneous — List any devices or data that doesn't belong to any other Category.

● Processors - Shows system processors.

● Storage — Shows mass storage devices such as floppy drives, optical drives, SATA, SAS hard
disk drives and controllers, as well as any RAID arrays.

● System — Shows information about motherboard devices such as fans and cables.
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Test tab
The Test tab lists all available diagnostics. The lists have been tailored according to your system
configuration. Individual test may be selected or unselected. The following Test Modes exist:

● Quick — This test selection was picked to perform quickly while covering your entire hardware.
Test parameters cannot be modified.

● Complete — This test selection offers all available tests and may take a long time to complete.
Test parameters cannot be modified.

● Custom — Like Complete this test selection offers all available tests. The test parameters may be
modified to fit specific needs. For advanced users only!

By default, the three test modes do not display prompts and require no interaction. If errors are found,
they are displayed when testing is complete.

However, for each test type, you may also optionally add interactive tests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control over
the testing process. The diagnostic software will prompt you for input during tests.

NOTE: Memory can not be tested from within the HP Vision Field Diagnostics application. To test the
memory in your workstation, exit HP Vision Field Diagnostic, boot to either the CD or USB flash drive
and select HP Memory Test from the boot menu.

The Duration of Test options control the duration of the test sequence. The following options are
available:

● Number of loops — A test selection will run once by default. Enter a positive number to make a
test selection run many times.

● Total test time (hours:minutes) — Alternatively, the test selection can be set to run for a specified
amount of time. This does not guarantee that all tests will run if the entered time is less than the
necessary time to run all the tests

● Stop at first error— Check this option to stop test execution as soon as one error is encountered.

The following Test Controls exist:

● Select All, Unselect All button — This button toggles to select or unselect all the tests from the
test selection tree.

● Expand, Collapse button — This button toggles to expand or collapse the test selection tree.

● Start Test button — Click this button to start executing all selected tests. HP Vision Field
Diagnostics will automatically switch to the Status tab in order to keep track of the test execution
and status.

WARNING! Once started, do not reboot or power off your computer until all the tests have been
completed.

To begin testing:

1. Select the Test tab.

2. Select the type of tests you want to run: Quick, Complete, or Custom.

3. Include optional interactive tests by selecting Include interactive tests.

4. Choose how you want the test to be executed, either Number of Loops or Total Test Time. When
choosing to run the test over a specified number of loops, enter the number of loops to perform. If
you want the diagnostic test for a specified time period, enter the amount of time in minutes.
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5. Click the Start Test button to start the testing. The Status tab, which allows you to monitor the
progress of the tests, is automatically displayed during the testing process. When the tests are
complete, the Status tab shows whether the devices passed or failed.

6. If errors are found, go to the Errors tab to display detailed information and recommended actions.
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Status tab
The Status tab shows the overall progress and status of the test scenario as well as the progress and
status of each test. The color coded status are black, blue, green, red, and orange.

The Status tab colors are:

● Waiting (black) — when no test is running

● Running (blue) — when at least one test is currently running

● Passed (green) — when all tests have run successfully, meaning that no hardware error or defect
have been detected

● Failed (red) — when thee tests have detected at least one error with your system

● Canceled (orange) — when the test scenario has been explicitly canceled, in which case no pass
or fail conclusion can be drawn

The available data is:

● Current Loop — Shows the current execution loop out of total number of loops specified in the
Test panel.

● Test Time — Shows the total time elapsed since the beginning of the test execution.

● Test Complete — Shows the number of tests successfully completed out of the total number of
test to execute.

● Cancel button — Push the Cancel button to immediately terminate all currently running tests.

History tab
The History tab shows the history of the past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the number
of times failed, the date each test was executed, and the time it took to complete each test. The Clear
History button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to either floppy or USB flash drive by
clicking the Save button.

Errors tab
The Errors tab displays detailed information about any errors found, as well as any recommended
actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.

● The Device section displays the device tested.

● The Test section displays the type of test run.

● The Times Failed is the number of times the device has failed a test.

● The Defect Code provides a numerical code for the failure. The error codes are defined in the Help
tab.

● The Description section describes the error that the diagnostic test found.

● The Reason section describes the likely cause of the error.
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● The Recommended Repair will give a recommended action that should be performed to resolve
the failed hardware.

● The Warranty ID is a unique error code associated with the specific error on your computer. When
contacting the HP Support Center for assistance with a hardware failure, please be prepared to
provide the Warranty ID.

● The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to either floppy or USB flash drive by clicking
the Save button.

Help tab
The Help tab contains a Vision Help section, and a Test Components section. This tab includes search
and index features. You may also review the HP End User License Agreement (EULA), as well as the
HP Vision Field Diagnostic application version information on this tab.

The various sections located here are:

● The Vision Help section contains information on the major functions of HP Vision Field Diagnostics.

● The Test components section provides a description of each test, as well as the parameters that
may be adjusted when running in Custom test mode.

● The Defect codes section contains information on the numerical error code that may appear in the
Errors tab.

● The Memory test tab section provides information on the HP Memory Test application that may be
launched from the boot menu.

● The HP Support section provides information on obtaining technical support from HP.
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Saving and printing information in HP Vision Field Diagnostics
You can save the information displayed in the HP Vision Field Diagnostics Survey, History and Errors
tabs to a diskette or a USB flash drive. You can not save to the hard drive. The system will automatically
create an html file that has the same appearance as the information displayed on the screen.

1. Insert a diskette or USB flash drive if running HP Vision Field Diagnostics from CD.

2. Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be saved
regardless of from which tab the Save button was clicked.

3. Select the drive onto which you will save the log files and click the Save button. Three html files
will be saved to the inserted diskette or USB flash drive.

NOTE: Do not remove the diskette or USB key until you see a message indicating that the html
files have been written to the media.

4. Print the desired information from the storage device used to save it.

NOTE: To exit HP Vision Field Diagnostics, click the Exit Diagnostics button at the bottom of
the screen. Be sure to remove the USB flash drive or CD from the optical drive.

Downloading the latest diagnostic utility
Follow these steps to download the latest diagnostic utility:

1. Go to http://www.hp.com.

2. Select the Support & Drivers link.

3. Select the Download driver and software radio button.

4. Enter your product number (for example, 800) in the text box, and then press Enter.

5. Select your operating system.

6. Select the Diagnostic link.

7. Locate HP Vision Field Diagnostics and select Download.

8. After the .iso file is downloaded, use CD-ROM burning software to copy the .iso file to an optical
medium.

Diagnostic codes and errors
This section presents information about diagnostic LED codes, LED color definitions, and POST error
messages to help you troubleshoot problems.

Diagnostic LED and audible (beep) codes
This section describes the front panel LED error and operation codes as well as the audible codes that
might occur before or during the POST.
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Table 6-8  Diagnostic lights and audible codes

Activity Possible cause Recommended action

Blue Power LED* on. No
beeps.

Workstation on.

N/A

Blue Power LED* blinks
every two seconds.* No
beeps.

Workstation in Sleep mode
(S3-Suspend to RAM).
Select models only.

Blue Power LED* is off.* No
beeps.

Workstation in Hibernate
mode (S4-Suspend to disk).

Blue Power LED* blinks
three times*, once per
second.* No beeps.

Workstation in Sleep mode
(S3-Suspend to RAM).
Select models only.

Blue Power LED* blinks four
times*, once per second.* No
beeps.

Workstation in Hibernate
mode (S4-Suspend to disk).

*User-selectable. See The Computer Setup (F10) Utility
menu on page 32 for details.

For the following LED activity and beeps, the beeps are heard through the chassis speaker. Blinks and beeps repeat for 5 cycles, after
which, only the blinks continue to repeat.

Red Power LED blinks two
times, once every second,
followed by a two-second
pause. Two beeps.

CPU thermal protection
activated by either of the
following methods:

● A fan might be blocked
or not turning.

● The heatsink and fan
assembly is not
properly attached to the
CPU.

CAUTION: Internal components might be powered even when the
workstation is off. To prevent damage, disconnect the workstation power
cord before you remove a component.

1. Ensure that the workstation air vents are not blocked and the cooling
fan is running.

2. Open the access panel, press power button, and verify that the CPU
fan is spinning. If the CPU fan is not spinning, make sure the fan
cable is plugged into the workstation board header. Ensure the fan
is fully and properly seated or installed.

3. If fan is plugged in and seated properly, but is not spinning, the
problem might be in the CPU fan. Contact HP for assistance.

4. Verify that the fan assembly is properly attached. If problems persist,
there might be a problem with the CPU heatsink. Contact HP for
assistance.

Red Power LED blinks three
times, once every second,
followed by a two-second
pause. Three beeps.

CPU not installed (not an
indicator of bad CPU).

1. Verify that the CPU is present.

2. Reseat the CPU.
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Activity Possible cause Recommended action

Red Power LED blinks four
times, once every second,
followed by a two-second
pause. Four beeps.

Power failure (power supply
is overloaded)

CAUTION: Internal components might be powered even when the
workstation is off. To prevent damage, disconnect the workstation power
cord before you remove a component.

1. Open the access panel and ensure that all power connections (24-
pin Main, 4-pin CPU) are secure on the system board.

2. Check if a device is causing the problem by removing all attached
devices (such as hard, diskette, or optical disk drives, and expansion
cards.) Power on the workstation. If the system enters the POST,
power off and replace one device at a time; repeat this procedure
until failure occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all devices are
functioning properly.

3. Check the power supply functionality.

a. Disconnect the AC power.

b. Disconnect ALL internal power supply cables.

c. Plug in the AC power.

If the power supply fan spins and the BIST** LED lights, the power supply
is functional. The problem might be on the system board. Contact HP for
assistance.

If the power supply fan does not spin or the BIST** LED does not light, the
problem might be in the power supply. Contact HP for assistance.

Red Power LED blinks five
times, once every second,
followed by a two-second
pause. Five beeps.

Pre-video memory error CAUTION: Internal components might be powered even when the
workstation is off. To prevent damage, disconnect the workstation power
cord before you remove a component.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate faulty module.

3. Replace third-party memory with HP memory.

4. The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks six
times, once every second,
followed by a two-second
pause. Six beeps.

Pre-video graphics error. CAUTION: Internal components might be powered even when the
workstation is off. To prevent damage, disconnect the workstation power
cord before you remove a component.

1. Reseat the graphics card.

2. Verify the graphics auxiliary power cable is connected (if applicable).

3. The problem might be on the graphics card. Contact HP for
assistance.

Red Power LED blinks
seven times, once every
second, followed by a two-
second pause. Seven
beeps.

System board failure (ROM
detected failure prior to
video).

1. Clear CMOS.

NOTE: Refer to the Maintenance and Service Guide for the
workstation model for detailed information on clearing CMOS.

2. The problem might be on the system board. Contact HP for
assistance.

Table 6-8  Diagnostic lights and audible codes (continued)
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Activity Possible cause Recommended action

Red Power LED blinks eight
times, once every second,
followed by a two-second
pause. Eight beeps.

Invalid ROM based on bad
checksum.

CAUTION: Internal components might be powered even when the
workstation is off. To prevent damage, disconnect the workstation power
cord before you remove a component.

1. Clear CMOS.

NOTE: Refer to the Maintenance and Service Guide for the
workstation model for detailed information on clearing CMOS.

2. Upgrade the ROM using SoftPaq, either from the hard disk drive,
CD, diskette, or USB removable device (for example, HP Drive Key).
See the ROM Flash section of the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals. SoftPaq
is a self-extracting executable, which contains instructions for its
use, that enables you to upgrade the ROM. To download the Softpaq
executable, visit http://www.hp.com/go/workstationsupport.

3. The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks nine
times, once every second,
followed by a two-second
pause. Nine beeps.

System powers on but does
not start.

● The problem might be on the system board. Contact HP for
assistance.

● The problem might be in the CPU. Contact HP for assistance.

System does not power-on
and LEDs are not blinking.
No beeps.

System unable to power on. CAUTION: Internal components might be powered even when the
workstation is off. To prevent damage, disconnect the workstation power
cord before you remove a component.

To resolve the problem, choose one of the following options:

Press and hold the power button for less than 4 seconds. If the hard disk
drive LED turns green, then:

1. Remove the expansion cards one at a time and try holding the power
button again for less than 4 seconds.

2. The problem might be on the system board. Contact HP for
assistance.

Press and hold the power button for less than 4 seconds. If the hard disk
drive LED does not turn on green then:

1. Check that unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button harness is
properly connected to the system board.

3. Check that all power supply cables are properly connected to the
system board.

4. Check the power supply functionality

a. Disconnect the AC power.

b. Disconnect all internal power supply cables.

c. Plug in the AC power.

If the power supply fan spins and the BIST** LED lights, the power supply
is functional. The problem might be on the system board. Contact HP for
assistance.

If the power supply fan does not spin or the BIST** LED does not light, the
problem might be in the power supply. Contact HP for assistance.

* The BIOS option you select controls the blue LED function during these suspend modes.
** Some workstation models do not have BIST LED functionality.

Table 6-8  Diagnostic lights and audible codes (continued)
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LED color definitions
The following table describes what each LED light on the workstation front panel signifies.

Table 6-9  LED color definitions

LED state LED color System status

Solid Blue System is on.

Flashing Blue System is in Standby.

Solid or flashing Red System has experienced an error. (See POST error
messages on page 139.)

None No light System is in Hibernate, or is off.
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POST error messages
The Power-On Self Text (POST) is a series of diagnostic tests that runs automatically when the
workstation is powered on.

Audible and visual messages occur before the operating system starts if the POST encounters a
problem. POST checks the following items to ensure that the workstation system is functioning properly:

● Keyboard

● DIMMs

● Diskette drives

● All mass storage devices

● CPUs

● Controllers

● Fans

● Temperature sensors

● Cables (front/rear panels, audio, and USB ports)

The table shown next describes the POST error messages.

Table 6-10  POST error messages 

Screen message Probable cause Recommended action

101—Option ROM Checksum
Error

System ROM checksum. Verify the you have the latest ROM:

1. Flash the ROM, if needed.

2. If an expansion card was recently added, remove
it to find out if the problem remains.

3. Clear CMOS. If the message disappears, there
might be a problem with the expansion card.

4. Replace the system board.

102—System Board Failure DMA, timers, and so forth, might be set
improperly or might be defective.

1. Clear the CMOS.

2. Remove the expansion boards.

3. Replace the system board.

110—Out of memory space for
option ROMs

Option ROM for a device could not run
because of memory constraints.

Run the Computer Setup (F10) Utility to disable
unneeded option ROMs, and to enable ACP0/USB
Buffers at Top of Memory.

162—Systems Options Error

163—Time and Date Not Set ● Invalid time or date in
configuration memory.

● RTC battery might need
replacement.

● CMOS jumper might not be
properly installed.

1. Set the date and time from the Control Panel or in
the Computer Setup (F10) Utility (depending on
the operating system).

2. If the problem persists, replace the RTC battery.
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Screen message Probable cause Recommended action

164—Memory Size Error Memory configuration is incorrect. 1. Run the Computer Setup (F10) Utility or the
Windows utilities.

2. Verify that the memory modules are installed
properly.

3. If third-party memory has been added, test the
memory configuration using HP memory.

4. Verify the memory module type.

201—Memory Error RAM failure. 1. Run the Computer Setup (F10) utility or the
Windows utilities.

2. Be sure that memory modules are installed
correctly.

3. Verify the memory module type.

4. Remove and replace memory modules one at a
time to isolate faulty modules.

5. Replace faulty memory modules.

6. If the error persists after replacing memory
modules, replace the system board.

202—Memory Type Mismatch Memory modules do not match. Replace the memory modules with matched sets.

203—Memory module failed
self-test and failing rank was
disabled

Defective memory module. Replace the memory module.

204—Memory module failed
and user rank was disabled

Improper module load. Reseat the memory module correctly.

205—Memory high
temperature detected

Insufficient memory module cooling. Verify that a memory module cooling fan is installed and
operating.

206—Memory setup invalid Memory configured incorrectly. Reconfigure the memory modules in the proper slots.

207—Incompatible DIMMs
detected

DIMMs are installed that do not fulfill
system requirements.

1. Verify that the memory module type matches
workstation requirements.

2. Insert the DIMM in the proper memory socket.

3. Replace the DIMM if the problem persists.

208—Mismatched DIMMs
detected

Installed DIMMs are improperly
matched.

Verify that matching DIMMs are installed.

209—Memory warning
condition detected

Incorrect memory module type in use. Verify that the memory modules are compatible with
workstation requirements.

212—Failed Processor 0 Processor has failed to initialize. 1. Reseat the processor in its socket.

2. If the processor does not respond, replace it.

3. Replace the system board.

213—Incompatible Memory
Modules

A memory module in the memory
socket identified in the error message
is missing critical SPD information, or
is incompatible with the chipset.

1. Verify the memory module type.

2. Insert the DIMM in another memory socket.

3. Replace the module with a DIMM conforming
to the SPD standard.

Table 6-10  POST error messages  (continued)
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Screen message Probable cause Recommended action

214—DIMM Configuration
Warning

DIMMs are not installed correctly (not
paired correctly).

See the service label on the workstation access panel
for the correct memory configurations, and reseat the
DIMMs accordingly.

215—DIMM Configuration
Error

216—Memory Size Exceeds
Maximum Supported

The amount of memory installed
exceeds that supported by the
hardware.

1. Verify how much memory the workstation
supports.

2. Remove the excess memory.

301—Keyboard Error Keyboard failure. 1. Reconnect the keyboard with the workstation
powered off.

2. Check the connector for bent or missing pins.

3. Be sure that none of the keys are pressed.

4. Replace the keyboard.

303—Keyboard Controller
Error

I/O board keyboard controller is
defective or is not set properly.

1. Reconnect the keyboard with the workstation
powered  off.

2. Connect a keyboard directly to the workstation
(instead of through a switch box).

3. Replace the system board.

304—Keyboard or System
Unit Error

Keyboard failure. 1. Reconnect the keyboard with the workstation
powered off.

2. Connect a keyboard directly to the workstation
(instead of through a switch box).

3. Be sure that none of the keys are pressed.

4. Replace keyboard.

5. Replace system board.

510—Splash Screen image
corrupted

Splash Screen image has errors. Update system BIOS.

511—CPU Fan not detected Fan is not connected or is defective. 1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.

512—Rear Chassis fan not
detected

Rear fan missing, disconnected, or
defective.

1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.

513—Front Chassis fan not
detected

Front fan missing, disconnected, or
defective.

1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.

514—Memory fan not
detected

Memory fan missing, disconnected, or
defective.

1. Verify that the memory fan is installed and
connected properly.

2. Replace the fan.

Table 6-10  POST error messages  (continued)
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Screen message Probable cause Recommended action

515—CPU Overtemp
occurred

Insufficient processor cooling or
processor defect.

1. If necessary, add a heatsink to the processor and
ensure proper operation.

2. Replace the processor.

516—Chipset fan not detected Chipset fan missing, disconnected, or
defective.

1. Ensure that the fan is installed and connected
properly.

2. Replace the fan.

517—Low power CPU
heatsink(s) detected for high
power CPUs

Inadequate heatsink is installed. Replace the low power heatsink with a high power
heatsink.

518—Power supply wattage
insufficient for hardware
configuration

Workstation configuration requires
more power than the power supply can
provide.

● Reduce the workstation power consumption.

● Replace the power supply with a high output
power supply.

601—Diskette Controller Error Diskette controller circuitry or diskette
drive circuitry incorrect.

1. Run the Computer Setup (F10) utility.

2. Verify cabling and replace defective cables if
necessary.

3. Clear CMOS.

4. Replace the diskette drive.

5. Replace the system board.

605—Diskette Drive Type
Error

Mismatch in drive type. 1. Run the Computer Setup (F10) Utility.

2. Disconnect any other diskette controller devices
(tape drives).

3. Clear the CMOS.

610—External Storage Device
Failure

External storage device is not
detected, is improperly connected, or
is defective.

1. Verify that the external device is present and
connected properly.

2. Replace the external device.

611—Primary Floppy Port
Address Assignment Conflict

The flexible disk drive is configured at
a previously assigned address.

Select a new address for the flexible disk drive.

912—Computer Cover Has
Been Removed Since Last
System Start Up

N/A No action required.

914— Hood Lock Coil is not
Connected

Mechanism is missing or is not
connected.

1. Reconnect or replace the missing mechanism.

2. Reseat or replace the missing mechanism cable.

916—Power Button Not
Connected

Power button cable is disconnected
from the system board.

Reconnect the cable and restart.

917—Front Audio Not
Connected

Front Audio mechanism is missing or
is not connected.

1. Replace or reconnect the missing front audio
mechanism to the system board.

2. Reseat or replace the missing mechanism cable.

918—Front USB Not
Connected

Front USB mechanism is missing or is
not connected.

1. Replace or reconnect the missing Front USB
mechanism to the system board..

2. Reseat or replace the missing mechanism cable.

Table 6-10  POST error messages  (continued)
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Screen message Probable cause Recommended action

919—Multi-Bay Riser Not
Connected

Multi-Bay riser mechanism is missing
or is not connected.

1. Replace or reconnect the missing Multi-Bay
mechanism to the system board.

2. Reseat or replace the missing mechanism cable.

920—Fatal error on QPI link X Fatal error detected on QPI link x,
where x is 0 or 1. This type of error is
identified on the line following the error
message.

System board problem; contact HP Support.

921—Fatal error on QPI
Protocol link X

Fatal error detected in QPI link x
protocol, where x is 0 or 1. This type of
error is identified on the line following
the error message.

Potential system board problem; contact HP Support.

922—Fatal error on PCIe slot
X

Fatal error occurred in the designated
slot.

Move the card to a different slot. If the problem persists,
replace the card.

923—Fatal error on ESI port 0 A fatal error occurred on ESI port 0.
slot.

Verify that the ESI port device is connected and working
properly.

924—Fatal error on IOH core
X

Fatal error detected on IOH core x,
where x is 0 or 1. This type of error is
identified on the line following.

Potential system board problem; contact HP Support.

925—Fatal error on IOH
miscellaneous

Fatal miscellaneous error detected on
IOH core x, where x is 0 or 1.

Potential system board problem; contact HP Support.

926—Fatal error on IOH Vtd Fatal error detected in the Intel
Virtualization Technology.

Potential system board problem; contact HP Support.

927—Fatal error on DIMM in
slot CPU X DIMM Y

Fatal multibit ECC error detected on
the DIMM in the slot labeled CPU x
DIMM y (where x is 0 or 1 and y is 1 -
6), as labeled on the system board.

Replace the DIMM in the identified slot.

928—Fatal machine check
detected on CPU X

Contact HP support.

1720—SMART Hard Drive
Detects Imminent Failure

Hard drive is about to fail. (Some hard
disk drives have a firmware patch that
fixes erroneous error messages.)

1. Determine if the hard disk drive is giving a correct
error message.

2. Run the Drive Protection System test (if
applicable).

3. Apply firmware patch (if applicable).
See  http://www.hp.com/support.

4. Back up contents and replace the hard disk drive.

1783—Fixed Disk 0/1 locked Hard disk drive failure. Diagnose the hard disk drive, and replace it if
necessary.

1796—SATA Cabling Error Missing or improperly attached cable. Verify that a cable is attached. Reattach the cable.

1797—SATA Drivelock is not
supported in RAID mode

SATA Drivelock is not supported in
RAID mode.

Disable RAID mode, or disable SATA drivelock..

1801—Microcode Update
Error

Unsupported processor (C0 Stepping
or greater only).

The microcode update failed. Check the processor
stepping to ensure it is a supported stepping. If it is
contact, HP Support.

1802—Processor Not
Supported

The system board does not support the
processor.

Replace the processor with a compatible one.

Table 6-10  POST error messages  (continued)
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Screen message Probable cause Recommended action

1803—Processor feature set
is insufficient for current
system settings

Processor feature set is insufficient for
current system settings. The BIOS
settings do not match the support
provided by the processor

Change the BIOS settings or upgrade the processors.

1804—A processor feature
and the memory configuration
are incompatible

A processor feature is incompatible
with the memory configuration.

Restore the previous memory configuration.

ERROR: Invalid 1394 GUID
(Invalid electronic serial
number)

No electronic serial number is stored
with the system.

To assign a serial number , select Security >System
IDs in the Computer Setup (F10) Utility.

ERROR: Invalid electronic
serial number (no number)

No electronic serial number is stored
with the system

To assign a serial number , select Security >System
IDs in the Computer Setup (F10) Utility.

ERROR: An unsupported
processor is installed. System
halted

Unsupported processor detected. Replace the processor.

ERROR: A processor requiring
too much power is installed.
System halted

Unsupported processor detected. Replace the processor.

Invalid electronic serial
number

Incorrect serial number registered in
the system.

Use the Computer Setup (F10) Utility to reset the serial
number.

Network Server Mode Active
and No Keyboard Attached

Keyboard not detected. Verify that a functioning keyboard is attached to the
workstation.

Processor initialization fails!!! Processor defective. Replace the processor.

Table 6-10  POST error messages  (continued)
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7 Configuring RAID devices

This chapter describes how to configure SAS and SATA RAID devices, and includes these topics:

Topics

Maximum hard drive configurations on page 145

Configuring SATA RAID devices on page 146

Configuring SAS RAID devices on page 150

For additional information about configuring RAIDs, see http://www.hp.com/support/RAID_FAQs. For
information about preparing the workstation for RAID configuration, see http://www.hp.com/support/
workstation_manuals.

Maximum hard drive configurations
This section lists the maximum number of hard drives supported on HP workstations for RAID
configurations.

NOTE: This section applies to internal workstation configurations that do not use add-in cards and
JBODs.

TIP: Use the table values to determine workstation-specific maximum number of hard drives as
discussed the sections below.

Table 7-1  Maximum hard drives

Workstation SATA hard drive SATA SFF*

hard drive

SAS hard drive

Z800 5 6 5

Z600 3 4 3

Z400 4 4 4

* Small form factor hard drive
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Configuring SATA RAID devices
This section describes how to use the Intel Matrix Storage Manager option ROM Configuration utility to
set up and manage SATA RAID volumes.

The following SATA RAID configurations are supported on this workstation:

● Up to the workstation-specific maximum number of internal SATA hard disk drives and eSATA
drives (if you use an optional eSATA bulkhead cable)

● Intel Matrix Storage Manager (IMSM) for Windows

If only a single HDD is attached, the Intel Matrix Storage Manager option ROM does not execute.
Associated messages are not displayed.

The Intel SATA AHCI BIOS executes when you select RAID+AHCI for the SATA emulation mode. This
BIOS is only used to support serial-attached optical drives.

This section does not apply to configuring SATA RAID in the Linux environment. For Linux SATA RAID,
refer to the Software RAID in Linux Workstations section in the HP Workstations for Linux User Guide
at http://www.hp.com/support/linux_user_manual.

Attaching SATA HDDs
Attach the required minimum number of SATA hard drives for the desired RAID level:

● RAID 0: two or more hard drives

● RAID 1: only two hard drives

● RAID 5: three or more hard drives

● RAID 10: only four hard drives
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Configuring system BIOS
Configure the system BIOS to enable embedded SATA RAID functionality.

1. To enter the system BIOS setup, press F10.

2. Use the arrow keys to highlight the desired language, and then press Enter.

3. Use the arrows to highlight Storage>Storage Options, and then press Enter.

4. Use the up or down arrow key to highlight SATA Emulation.

5. Use the left or right arrow key to select RAID+AHCI.

6. To accept the new setting, press F10.

7. Use the arrows to highlight Advanced>Power-On Options, and then press Enter.

8. Use the up or down arrow key to highlight POST Messages.

9. Use the left or right arrow key to select Enable.

10. To accept the new setting, press F10.

11. Use the arrow keys to highlight Advanced>Device Options, and then press Enter.

12. Use the up or down arrow key to highlight SATA RAID Option ROM Download, and then press
Enter.

13. Use the left or right arrow key to select Enable.

14. To accept the new setting, press F10.

15. Use the arrows to highlight File>Save Changes and Exit, and then press Enter.

16. Press F10 when prompted.
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Creating RAID volumes
To create RAID volumes, use the Intel Matrix Storage Manager option ROM Configuration utility.

1. To enter the Intel Matrix Storage Manager option ROM Configuration utility, press Ctrl+l when
prompted

2. If required, see Deleting RAID volumes on page 149 to make enough physical drives available to
create the RAID volume.

3. Use the up or down arrow key to highlight 1. Create RAID Volume, and then press Enter.

4. Type the desired RAID volume name in the Name: field, and then press Tab.

5. Use the up or down arrow key to select the RAID level in the RAID Level: field, and then press
Tab.

6. To display the Select dialog, press Enter.

7. Use the up and down arrow keys and Space to mark individual physical as members of the volume.

8. To exit the Select dialog and return to the Create Volume Menu dialog, press Enter.

9. If appropriate, use the up or down arrow key to select the Strip Size in the Strip Size: field, and
then press Tab.

10. Enter the desired volume size in the Capacity: field, and then press Tab.

11. Press Enter to initiate volume creation.

12. When prompted, press Y to acknowledge the warning message and create the volume.

13. Return to step 3 to create additional RAID volumes, or use the up or down arrow key to highlight
4. Exit, and then press Enter.

14. Press Y when prompted to confirm the exit.
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Deleting RAID volumes
Use the LSI Logic Corporation Configuration Utility to delete SAS RAID volumes.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to Press
Ctrl-C to start LSI Corp. Configuration Utility.

2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

3. Press Enter to go to the Adapter Properties screen.

4. In the Select New Array Type screen, use the arrow keys to select New Existing Array.

5. In the View Array screen, use the arrow keys to select Manage Array. Press Enter.

6. In the Manage Array screen, use the arrow keys to select Delete Array. Press Enter.

Press Y to delete the array and exit to the adapter properties screen.
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Configuring SAS RAID devices

Supported configurations
The following RAID configurations are supported on this workstation:

NOTE:  This section does not apply to configuring SAS RAID in the Linux environment. For Linux SAS
RAID information, including supported configurations, refer to Installing and Configuring SAS Hardware
RAID on HP Linux Workstations at http://www.hp.com/support/xw8600_manuals.

● Up to the workstation-specific maximum number of internal SAS hard disk drives

● LSI MegaRAID Storage Manager (MSM) for Windows

The following RAID configurations are supported on this workstation:

● RAID 0 – Striped disk array (IS)

◦ Two drive minimum

◦ Improved I/O performance

◦ No fault tolerance

● RAID 1 — Mirrored disk array (IM)

◦ Two drives

◦ 100% redundancy

◦ Can recover from single drive failure

◦ Improved read performance

● RAID 1E (IME)

◦ Three drives minimum

◦ Can be an odd number of drives

◦ Can always recover from a single drive failure and, in some cases, can recover from two drive
failures
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SAS RAID 0 configuration
Use the following procedure to configure an Integrated Striped (IS) volume with the BIOS-based
configuration utility. The procedure assumes that the system has the required disk and disk controllers.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to Press
Ctrl-C to start LSI Corp. Configuration Utility.

2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

3. Press Enter to go to the Adapter Properties screen.

4. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and press
Enter to go to the New Array Type screen.

5. In the Select New Array Type screen, use the arrow keys to select Create IS Volume. Press
Enter to go to the Create New Array screen.

6. In the Create New Array screen, use the arrow keys to select the first disk for the IS volume. Then
use the arrow keys to move to the RAID Disk column for this disk, and press Space and + or - to
select Yes as the value for this column.

If partitions are defined on the selected disk, a message appears warning you that data on the disk
will be lost when the striped volume is created.

7. Press M to migrate, or D to delete the data on the drive.

8. To select additional drives for the striped volume, up to the workstation-specific maximum number,
repeat the previous steps.

9. When all drives are selected, press C to create the array once. Use the arrow keys to move to
Save changes then exit this menu and press Enter.

10. When the new array is created, the Adapter Properties screen appears. Press Esc twice and
select Exit.
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SAS RAID 1 configuration
Use the following procedure to configure an Integrated Mirroring (IM) volume with the BIOS-based
configuration utility. The procedure assumes that the system has the required drives and drive
controllers.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to Press
Ctrl-C to start LSI Corp. Configuration Utility.

2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

3. Press Enter to go to the Adapter Properties screen.

4. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and press
Enter to go to the New Array Type screen.

5. In the Select New Array Type screen, use the arrow keys to select Create IM Volume. Press
Enter.

6. To configure a two-disk mirrored volume with an optional hot spare disk:

a. In the Create New Array screen, use the arrow keys to select the primary disk for the IM volume
(the disk with the data you want to mirror.)

b. Use the arrow keys to move to the RAID Disk column for this disk and press Space to
select Yes as the value.

If partitions are defined on the selected disk, a message appears warning you that data on
the disk will be lost when the mirrored volume is created.

c. Press M to migrate or D to delete the data on the drive.

d. The value in the Array Disk column changes to Primary.

Use the arrow keys to select the secondary (mirrored) disk for the IM volume, and then
select Yes as the value for the Array Disk column.

If partitions are defined on this disk, a message warns that data on the disk will be lost when
the mirrored volume is created.

e. Press Delete to confirm erasing data from the disk, or press any other key to deselect the
disk.

7. When all drives are selected, press C to create the array once. Use the arrow keys to move to
Save changes then exit this menu and press Enter.

8. When the new array is created, the Adapter Properties screen appears. Press Esc twice and
select Exit.
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SAS RAID 1E configuration
Use the following procedure to configure an Integrated Mirroring Extended (IME) volume with the BIOS-
based configuration utility. The procedure assumes that the system has the required disk and disk
controllers.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to Press
Ctrl-C to start LSI Corp. Configuration Utility.

2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

3. Press Enter to go to the Adapter Properties screen.

4. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and press
Enter to go to the New Array Type screen.

5. In the Select New Array Type screen, use the arrow keys to select Create IME Volume. Press
Enter.

6. To configure a mirrored volume or an optional hot spare drive with up to the workstation-specific
maximum number of drives:

a. In the Create New Array screen, use the arrow keys to select the first disk for the IME volume.

b. Use the arrow keys to move to the RAID Disk column for this disk, and then use the + or -
keys to select Yes as the value.

If partitions are defined on the selected disk, a message appears warning that the data on the
disk will be lost when the mirrored volume is created.

c. Press M to migrate, or D to delete the data on the drive.

d. Use the arrow keys to select the next disk for the IME volume, and then select Yes as the
value for the Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created.

e. Press Delete to confirm erasing data from the disk, or press any other key to deselect the
disk.

f. Repeat the previous steps to select up to the workstation-specific maximum number of drives
for the IME volume, including configuration of a hot spare.

7. When all drives are selected, press C to create the array once. Use the arrow keys to move to
Save changes then exit this menu and press Enter.

8. When the new array is created, the Adapter Properties screen appears. Press Esc twice and
select Exit.
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8 Configuring password security and
resetting CMOS

This chapter describes how to configure password security and to reset CMOS, and includes these
topics:

Topics

Preparing to configure passwords on page 155

Resetting the password jumper on page 156

Clearing and Resetting the CMOS on page 156
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Preparing to configure passwords
The Computer Setup (F10) Utility enables you to create setup and power-on passwords.

There are three possibilities for setting passwords:

● Define a setup password only

● Define a power-on password only

● Define both

When defining a setup password only, you cannot enter the setup utility without the password.

No password is needed to start from power-on.

When defining a power-on password only, the power-on password is needed to enter F10 Setup or to
start from power-on.

When defining both, the setup password is needed to enter F10 setup and can be used to start from
power-on.

The power-on password cannot be used to enter the F10 Setup Utility, but it can be used to start from
power-on.

One of the passwords will be required to start from power on.

After you create both passwords, you can use the setup password in place of the power-on password
as an override to log into the workstation (a useful feature for a network administrator).

NOTE: You can only clear the passwords with the password jumper. Clearing CMOS does not clear
the passwords.

CAUTION: Before pressing the Clear CMOS button, back up the workstation CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized
information, including passwords, asset numbers, and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to Diskette from
the File menu.
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Resetting the password jumper
Use the following procedure to disable the power-on or setup password features and clear the power-
on and setup passwords.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect
the power cord from the wall outlet and let the internal system components to cool before touching.

CAUTION: When the workstation is plugged in, the power supply has voltage applied to the system
board, even when the workstation is turned off. Failure to disconnect the power cord can result in
damage to the workstation.

CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Shut down the operating system, power off the workstation and external devices, and disconnect
the workstation power cord and external devices from power outlets.

2. Disconnect the keyboard, monitor, and other external devices that are connected to the
workstation.

3. Remove the access panel.

4. Locate the password header and jumper.

The password header is E49. The password jumper is green so it can be easily identified.

5. Verify that the AC power cord is disconnected from the power outlet.

6. Remove the jumper from pins 1 and 2, then replace it.

NOTE: You have to restart to at least the point where you get video before you can shut down
again and replace the jumper to clear the passwords.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Connect AC power to the workstation, power on the workstation, and then boot to the F10 (Setup)
Utility.

10. To create new passwords, repeat steps 1 through 8, and then create the new passwords using the
F10 (Setup) Utility.

Clearing and Resetting the CMOS
This section describes the steps necessary to successfully clear and reset the CMOS. The CMOS of
the workstation stores password information and information about the workstation configuration.

Using the CMOS Button
To clear CMOS using the Clear CMOS button, use the following procedure:

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.
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CAUTION: When the workstation is plugged in, the power supply has voltage applied to the system
board, even when the workstation is powered off. Failure to disconnect the power cord can result in
damage to the workstation.

Static electricity can damage the electronic components of the workstation or optional equipment. Before
beginning these procedures, be sure that you are discharged of static electricity by briefly touching a
grounded metal object.

1. Shut down the operating system, power off the workstation and any external devices, and then
disconnect the workstation power cord and external devices from power outlets.

2. Disconnect the keyboard, monitor, and other external devices that are connected to the
workstation.

3. Remove the access panel.

CAUTION: Before pressing the Clear CMOS button, back up the workstation CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized
information, including passwords, asset numbers, and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to
Diskette from the File menu.

4. Locate, press, and hold the CMOS button for five seconds.

NOTE: Verify that the AC power cord is disconnected from the power outlet.

The CMOS button does not clear CMOS if the power cord is connected.

For assistance locating the CMOS button and other components, see Clearing and Resetting the
CMOS on page 156.

5. Replace the access panel.

6. Reconnect external devices.

7. Plug in and power on the workstation.

8. Reset the workstation passwords and configuration information, such as the system date and time.

The workstation powers up for three to five seconds, then powers down.

Using the Computer Setup (F10) Utility to Reset CMOS
To reset CMOS using the Computer Setup (F10) Utility:

1. Access the Computer Setup (F10) Utility menu.

2. When the Computer Setup message appears in the lower-right corner of the screen, press F10,
and then press Enter to bypass the title screen, if necessary.

If you do not press F10 while the message is displayed, the workstation must be restarted to access
this utility.

3. From the Computer Setup (F10) Utility menu, select File>Default Setup.

This restores the settings that include boot sequence order and other factory settings. However, it
does not force hardware rediscovery.

4. Choose Restore Factory Settings as Default, and the press F10 to accept.
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5. Select File->Apply Defaults and Exit, and then press F10 to accept.

6. Reset the workstation passwords and configuration information, such as the system date and time.

NOTE: This step does not clear the passwords.
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A Connector pins

Workstation keyboard Pin Signal

1

2

3

Data

Unused

Ground

4

5

6

+5 VDC

Clock

Unused

Workstation mouse Pin Signal

1

2

3

Data

Unused

Ground

4

5

6

+5 VDC

Clock

Unused

Workstation Ethernet Pin 10/100–MbSignal 1000–Mb
signal

1

2

3

4

(+) Transmit Data

(-) Transmit Data

(+) Receive Data

Unused

TX/RX

TX/RX

TX/RX

TX/RX

0

0

1

2

+

–

+

+

5

6

7

8

Unused

(-) Receive Data

Unused

Unused

RX/RX

TX/RX

TX/RX

TX/RX

2

1

3

3

–

–

+

–
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Workstation USB Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

Ground

Microphone cable (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio

Power

Ground

Headphone cable (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio_Left

Audio_Right

Ground

Audio line-in cable (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio_In_Left

Audio_In_Right

Ground

Line-out audio cable (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio_Out_Left

Audio_Out_Right

Ground

SATA drive  

Pin Signal Pin Signal Pin Signal  

Data Cable Power Cable Power Cable  

S1 Ground P1 3.3V power P8 5V power

S2* A+ P2 3.3V power P9 5V power
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SATA drive  

Pin Signal Pin Signal Pin Signal  

Data Cable Power Cable Power Cable  

S3* A- P3 3.3V power P10 Ground

S4 Ground P4 Ground P11 Reserved

S5** B- P5 Ground P12 Ground

S6** B+ P6 Ground P13 12V power

S7 Ground P7 5V power P14 12V power

* S2 and S3 differential signal pair

**S5 and S6 differential signal pair

P15 12V power

SAS drive

Segment Pin Backplane
receptacle

Plug and
cable
receptacles

Primary signal segment S1 SIGNAL GROUND

S2 TP+ RP+

S3 TP- RP-

S4 SIGNAL GROUND

S5 RP- TP-

S6 RP+ TP+

S7 SIGNAL GROUND

Secondary signal segment S8 SIGNAL GROUND

S9 TS+ RS+

S10 TS- RS-

S11 SIGNAL GROUND

S12 RS- TS-

S13 RS+ TS+

S14 SIGNAL GROUND
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SAS drive

Segment Pin Backplane
receptacle

Plug and
cable
receptacles

Power segment P1 V33
c

P2 V33
c

P3 V33
c precharge c

P4 GROUND

P5 GROUND

P6 GROUND

P7 V5
c precharge c

P8 V5
c

P9 V5
c

P10 GROUND

P11 READY LED d

P12 GROUND

P13 V12 precharge c

P14 V12
c

P15 V12
c

Workstation VGA

Pin Signal Pin Signal Pin Signal

1

2

3

Red Analog

Green Analog

Blue Analog

6

7

8

GND

GND

GND

11

12

13

Monitor ID

DDC Serial Data

Horizontal Sync

4

5

Monitor ID

GND

9

10

+5 VDC

GND

14

15

Vertical Sync

DDC Serial Clock
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DVI-I cable

Pin Signal Pin Signal

1 T.M.D.S DATA 2- 16 HOT PLUG DETECT

2 T.M.D.S DATA 2+ 17 T.M.D.S DATA 0-

3 T.M.D.S DATA 2/4 SHIELD 18 T.M.D.S DATA 0+

4 T.M.D.S DATA 4- 19 T.M.D.S DATA 0/5 SHIELD

5 T.M.D.S DATA 4+ 2 0 T.M.D.S DATA 5-

6 DDC CLOCK 21 T.M.D.S DATA 5+

7 DDC DATA 22 T.M.D.S CLOCK SHIELD

8 ANALOG VERT. SYNC 23 T.M.D.S CLOCK+

9 T.M.D.S DATA 1- 24 T.M.D.S CLOCK-

10 T.M.D.S DATA 1+

11 T.M.D.S DATA 1/3 SHIELD C1 ANALOG RED

12 T.M.D.S DATA 3- C2 ANALOG GREEN

13 T.M.D.S DATA 3+ C3 ANALOG BLUE

14 +5V POWER C4 ANALOG HORZ SYNC

15 GND C5 ANALOG GROUND

Display port

Pin Signal Pin Signal

1 ML_Lane 0(p) 11 GND

2 GND 12 ML_Lane 3(n)

3 ML_Lane 0(n) 13 GND
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Display port

4 ML_Lane 1(p) 14 GND

5 GND 15 AUX CH(p)

6 ML_Lane 1(n) 16 GND

7 ML_Lane 2(p) 17 AUX CH(n)

8 GND 18 Hot Plug Detect

9 ML_Lane 2(n) 19 DP_PWR Return

10 ML_Lane 3(p) 20 DP_PWR

Main power cable, P1

1 12

13 24

Pin Signal Pin Signal Pin Signal

1 +3.3V 9 +5 Vaux 17 GND

2 +3.3V 10 +12 V-B 18 GND

3 GND 11 +12 V-B 19 GND

4 +5V 12 12 V-D 20 GND

5 GND 13 +3.3V 21 +5V

6 +5V 14 –12V 22 +5V

7 GND 15 GND 23 12 V-D

8 POK 16 PS_ON_L 24 GND
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CPU power cable, P3 Pin Color Signal

1 BLK GND

2 BLK GND

3 WHT 12V CPU

4 WHT 12V CPU

CAUTION: Ensure that you can differentiate between which power cable
connects to the PCIe x16 graphics card and which power cable connects to the
system board. These two cables have different pin counts and different colors.
The PCIe power cable has a 6-pin black connector, and the CPU power cable has
an 4-pin white connector. When power is present, you must never connect the
PCIe power cable to the system board. If you do so, the system board can be
damaged and the warranty voided. To see a picture of the PCIe cable and where
it must be connected, see Expansion cardon page 93.

NOTE: The 6-pin power (auxiliary PCIe) is only required with high-powered
graphics cards.

Graphics aux. power cables, P12 Pin Signal Color

4 6

31

1 V12-D YEL

2 V12-D YEL

3 V12-D YEL

4 GND BLK

5 GND BLK

6 GND BLK

Internal USB 1 2x5 Pin Signal

1 +5V

2 +5V

3 USB6#

4 USB9#

ENWW 165



Internal USB 1 2x5 Pin Signal

CAUTION: Possible equipment damage.

The 2x5 connector can be mated to either
a wide 2x5 option cable connector or a
narrow 1x5 option cable connector.

To prevent damage to the connectors,
always connect a narrow 1x5 option cable
connector to pins 1,3,5, and 7 only of the
2x5 connector (pin 9 is not keyed on the
connector).

5
USB6

6
USB9

7
GND

8

8

GND

9
(not keyed)

10
DETECT

Internal USB 2 2x5 Pin Signal

1 +5V

2 +5V

3 USB7#

4 USB8#

CAUTION: Possible equipment damage.

The 2x5 connector can be mated to either
a wide 2x5 option cable connector or a
narrow 1x5 option cable connector.

To prevent damage to the connectors,
always connect a narrow 1x5 option cable
connector to pins 1,3,5, and 7 only of the
2x5 connector (pin 9 is not keyed on the
connector).

5
USB7

6
USB8

7
GND

8

8

GND

9 (not keyed)

10 DETECT

Workstation rear system fan Pin Signal

1 GND

2 +12V

3 Tach

4 PWM
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Workstation CPU fan Pin Signal

1 GND

2 +12V

3 TACH1

4 PWM

5 TACH2

Workstation FDD Pin Signal Pin Signal

1 Ground 18 FLP_DIR#

2 FLP_LOWDEN# 19 Ground

3 Tach 20 FLP_STEP#

4 FLP_WDO 21 Ground

5 MT 22 FLP_STEP#

6 Unused 23 Ground

 7 Ground 24 FLP_WRTEN#

 8 FLP_INDEX# 25 Ground

 9 Ground 26 FLP_TRACK#

 10 FLP_MOTOR# 27 Ground

 11 Ground 28 FLP_WP#

 12 Unused 29 Ground

 13 Ground 30 FLP_RD_D#

 14 FLP_SEL_A# 31 Ground

 15 Ground 32 FLP_HD_SEL#

 16 Unused 33 Ground

 17 Ground 34 FLP_DSKCHG#
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Workstation internal serial Pin Signal Pin Signal

1 DTR1# 9 +5V

2 RXD1 10 +3.3V AUX

3 CTS1# 11 RTS1#

4 DSR1# 12 COM DETECT

5 TXD1 13 DCD21#

6 RI# 14 -12V

7 Ground 15 +12V

8 Ground

168 Appendix A   Connector pins ENWW



B System board designators

This appendix describes the system board designators for this workstation. PENDING

Designator Silk screen Component

MTG1-MTG10 N/A Mounting holes

E15 E15 Crisis recovery header/jumper

E49 E49 PSWD Clear password header/jumper

J9 J9 RJ/USB LAN/DUAL USB

J10 J10 QUAD USB Quad rear USB

J20 J20 SLOT6 PCI PCI slot

J21 J21 SLOT5 PCI PCI slot

J31 J31 SLOT1 PCIe2 x8(4) PCIe2 x8(4) slot

J32 J32 SLOT3 PCIe x8(4) PCIe x8(4) slot

J41 J41 SLOT2 PCIe2 x16 75W PCIe2 x16 slot

J42 J42 SLOT4 PCIe2 x16 75W PCIe2 x16 slot

J68 J68 PS2 KBD_MSE Stacked keyboard/mouse connector

J83 J83 AUD Triple stacked audio jacks

J86 J86 Slot2 PCIe x16 retention clip

J87 J87 Slot4 PCIe x16 retention clip

SW50 SW50 CMOS Clear CMOS switch/push button

P1 P1PWR Power supply connector (24-pin)

P3 P3 PWR CPU CPU power connector (4-pin)

P5 P5 PB/LED Power button/HDD LED/Power LED switch/
Side access panel sensor/Temperature header

P8 P8 REAR FAN Rear system fan

P10 P10 FLPY Floppy diskette drive connector

P24 P24 FRONT USB Front panel USB header

P25 P25 USB2 Single USB header

P26 P26 DASH/USB1 DASH/Dual internal USB

P29 P29 HDD LED Hard disk drive LED connector

P60-P63 P60 - P63

SATA0 - SATA3

SATA Connectors
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Designator Silk screen Component

P66 - P67 P66 - P67

SATA4 - SATA5

SATA Connectors

P70 P70 CPU0 FAN Primary CPU fan header

P93 P93 FRNTFAN Front fan header

P94 P94 IOH FAN IOH fan header

P124 P124 HLCK Side access panel solenoid lock header

XBT1 XBT1 BAT Battery holder

XMM1 - XMM6 XMM1 - XMM4

DIMM1 - DIMM4

Memory slots

XU1 XU1 CPU0 Primary CPU socket
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C Routine Care

General cleaning safety precautions
● Never use solvents or flammable solutions to clean the workstation.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

● Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

● Always disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the workstation case
● Follow the safety precautions presented (Service considerations on page 60) before cleaning the

workstation.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

● After cleaning, always wipe the workstation with a clean, lint-free cloth.

● Occasionally, clean the air vents on the workstation. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.

● Follow the safety precautions presented (Service considerations on page 60) before cleaning the
workstation.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.

CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.
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● Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not
to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
● Follow the safety precautions presented (Service considerations on page 60) before cleaning the

workstation.

● To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or
a clean cloth moistened with water.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.

Cleaning the mouse
1. Follow the safety precautions presented (Service considerations on page 60) before cleaning the

workstation.

2. Remove the mouse ball from the housing by removing the retaining plate.

3. Clean the mouse ball.

4. Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5. Reassemble the mouse.
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D Locating HP resources

This section provides information on the following HP resources for your workstation:

Topics

Product information on page 174

● HP Cool Tools

● Regulatory information

● Accessories

● System board

● Serial number and Certificate of Authenticity labels

● Linux

Product support on page 175

● Additional information

● Technical support

● Business Support Center

● IT Resource Center

● HP Service Center

● HP Business and IT Services

● Warranty information

Product documentation on page 176

● User and third-party documentation, and white papers

● Product notifications

● QuickSpecs

● Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 177

● Documentation and Diagnostics CD

● Diagnostics tools

● Audible beeps and LED code definitions

● Web-based support tools

Product updates on page 178

● Software, BIOS, and driver updates

● Operating system reinstallation

● Operating system
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Product information
Table D-1  Product information

Topic Location

HP Cool Tools Most HP Microsoft Windows workstations are preloaded
with additional software that is not automatically installed
during first boot. Additionally, a number of valuable tools on
your workstation are preinstalled that may enhance system
performance. To access or learn more about these
applications, choose one of the following options:

● Click the HP Cool Tools icon on the desktop, or

● Open the HP Cool Tools folder by selecting Start >
All Programs > HP Cool Tools.

To learn more about these applications, click HP Cool
Tools—Learn More.

To install or launch the applications, click the appropriate
application icon.

Regulatory information Refer to the Safety & Regulatory Information guide on the
Documentation and Diagnostics CD for product Class
information. You can also refer to the label on the
workstation chassis.

Accessories For complete and current information on supported
accessories and components, visit http://www.hp.com/go/
workstations.

System board A diagram of the system board is located on the inside of
the side access panel. Also, additional information is located
in the Maintenance and Service Guide on the Web at
http://www.hp.com/support/workstation_manuals/.

Serial number and Certificate of
Authenticity (COA) labels (if
applicable)

Serial number labels are on the top panel, or on the side of
the unit at the rear, depending on the workstation model.
The COA label is generally located on the top or side panel
near the serial number label. Some workstations have this
label on the bottom of the unit.

Linux For information on running Linux on HP workstations, visit
http://www.hp.com/linux/.
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Product support
Table D-2  Product support

Topic Location

Additional information For online access to technical support information and tools,
visit http://www.hp.com/go/workstationsupport.

Support resources include Web-based troubleshooting
tools, technical knowledge databases, driver and patch
downloads, online communities, and proactive notification
services.

The following communication and diagnostic tools are also
available:

● Instant Chat

● Instant Support

● Diagnose Problem

Refer to Instant Support and Active Chat on page 114 for
more information on how to receive support.

Technical support Before you call technical support, see Calling technical
support on page 109 for a listing of information you need to
have available before you call.

For a listing of all worldwide technical support phone
numbers, visit http://www.hp.com/support/, select your
region, and click Contact HP in the upper-left corner.

Business Support Center (BSC) For software/driver downloads, warranty information,
single-topic documents, user manuals, or service manuals,
visit http://www.hp.com/go/bizsupport.

IT Resource Center (ITRC) Visit http://www.itrc.hp.com/ for a searchable knowledge
base for IT professionals.

HP Business and IT Services. For business and IT information, visit http://www.hp.com/
hps/.

HP Hardware Support Services For hardware service information, visit http://www.hp.com/
hps/hardware/.

Warranty information To locate base warranty information, visit
http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, visit http://www.hp.com/go/
lookuptool.

To extend a standard product warranty, visit
http://www.hp.com/hps/carepack. HP Care Pack Services
offer upgraded service levels to extend and expand a
standard product warranty.
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Product documentation
Table D-3  Product documentation

Topic Location

HP user documentation, white
papers, and third-party
documentation

For the latest online documentation, visit
http://www.hp.com/support/workstation_manuals. These
include this User Guide and the Maintenance and Service
Guide.

Product notifications Subscriber's Choice is an HP program that allows you to
sign up to receive driver and software alerts, proactive
change notifications (PCNs), the HP newsletter, customer
advisories, and more. Sign up at http://www.hp.com/go/
subscriberschoice/.

Customer advisories and product change notifications are
also available on http://www.hp.com/go/bizsupport/.

Workstation QuickSpecs The Product Bulletin contains QuickSpecs for HP
Workstations. QuickSpecs provide an overall specification
review of your product. It includes information about its
features including the operating system, power supply,
memory, CPU, and many other components of the system.
To access the QuickSpecs, visit http://www.hp.com/go/
productbulletin/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. From the Resources section, select See more…

4. Use the scroll bar to select Customer Advisories,
Customer Bulletins, or Customer Notices.
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Product diagnostics
Table D-4  Product diagnostics

Topic Location

Documentation and Diagnostics CD
contents

The Documentation and Diagnostics CD includes:

● Warranty Booklet

● User Guide

● Maintenance and Service Guide (Web only link)

● Safety and Comfort Guide

● Safety & Regulatory Information Guide

● User task-specific instructions

Diagnostics tools The HP Vision Field Diagnostics utility can be downloaded
from the HP Web site. To use this utility, see Self-
troubleshooting with HP Vision Field Diagnostics
on page 126

Audible beep and LED code
definitions

Refer to Diagnostic LED and audible (beep) codes
on page 134 for detailed information about beep and Light
Emitting Diode (LED) codes applicable to the workstation.
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Product updates
Table D-5  Product updates

Topic Location

Software, BIOS, and driver
updates

Verify that you have the latest drivers for your system by
visiting http://www.hp.com/go/workstationsupport.

To locate the current workstation BIOS on your Microsoft
Windows workstation, select Start>Help and Support>Pick a
Task>Use Tools to view...>Tools>My Computer
Information>View general system information....

Operating system For information on operating systems supported on HP
workstations, visit http://www.hp.com/go/wsos.

178 Appendix D   Locating HP resources ENWW

http://www.hp.com/go/workstationsupport
http://www.hp.com/go/wsos


Index

A
Appendices

Connector pins iii
System board designators iii

B
BIOS

Determining version vi
Updating vi

BIOS ROM vi

C
Clearing and resetting CMOS xi
Computer Setup (F10) Utility

Menu description vi
Configuring RAID devices

SAS RAID x
SATA RAID x

Connector pins
Audio line-in 160
Audio line-out 160
CPU fan 167
CPU power cable 165
Display port 163
DVI-I 163
Ethernet 159
FDD 167
Graphics aux. power 165
Headphone 160
Internal serial 168
Internal USB 165,  166
Keyboard 159
Main power cable 164
Microphone 160
Mouse 159
Rear system fan 166
SAS drive 161
SATA drive 160
USB 160
VGA 162

D
Diagnostic codes and errors

LED and beep codes x

LED colors x
POST errors x

Diagnostics and troubleshooting
Diagnosis guidelines ix
HP Vision Field Diagnostics x
Locating ID labels ix
Locating warranty info ix

Drivers
Installing v
Updating v,  vi

H
HP Backup and Recovery vi
HP resources

Locating iii
Product diagnostics xi
Product documentation xi
Product information xi
Product support xi
Product updates xi
Web links xi

M
Microsoft Windows

Setting up v
Transferring files v

monitor
Windows x

N
Novell SLED

Restoring vi
Setting up vi

O
Operating system setup

Microsoft Windows v
Red Hat Linux v

Operating system setup; Novell
SLED vi

P
Password security

Configuring passwords xi
Resetting password jumper xi

Power supply
Currents v
Power consumption v
Resetting power supply v
Specifications v
System fans v
Voltages v

Product features
EUP compliance mode v
Front panel components v
HP Cool Tools v
Hyper-threading v
Physical characteristics v
Rear panel components v
System board architecture v
Turbo Boost v
Workstation components v

Product overview iii

R
Red Hat Linux

Setting up v
Replacing components

Access panel viii
Battery ix
cable lock viii
Component locations viii
CPU ix
CPU heatsink ix
Disassembly order viii
Front panel I/O device viii
Memory viii
Optical disk drive viii
PCIe card ix
Power button viii
Power connections viii
Power supply viii
Predisassembly viii
Rear system fan viii
Self-repair viii

ENWW Index 179



Service considerations vii
side access panel sensor viii
side access panel solenoid viii
Slot identification ix
System board ix
Workstation speaker viii

RestorePlus! vi
Restoring the operating system

Restore methods vi
Windows Vista vi
Windows XP vi

S
Software

Ordering vi
Support

Locating HP resources iii

U
Updating the workstation

First boot update vi
Updating drivers vi
Updating the BIOS vi

W
Windows operating system

monitor x
Windows Vista

Restoring vi
Setting up v

Windows XP
Restoring vi
Setting up v

Workstation management
Altiris Client Management

Solutions vi
Dual-state power button vii
FailSafe Boot Block ROM vii
Fault notification and

recovery vii
HP Client Manager

Software vi
HPQFlash vii
Initial configuration vi
Proactive Change

Notification vi
Remote ROM Flash vii
Remote system install vi
Replicating the setup vi
ROM Flash vii
Subscriber's Choice vii

System Software Manager vi
Updating software vi
Workstation security vii

Workstation setup
Ensuring proper ventilation v

180 Index ENWW


	Product overview
	Product features
	System board architecture
	Processor technology
	Memory technology
	Graphics
	Expansion card slots
	Additional features

	Workstation components
	Chassis components
	Front panel components
	Rear panel components


	Workstation specifications
	Physical characteristics
	Power supply description
	Power supply voltages
	Power supply currents
	Power supply specifications
	Power consumption and heat dissipation
	System fans
	Resetting the power supply

	Environmental specifications
	ENERGY STAR Qualification
	EUP compliance mode
	Enabling EUP compliance mode
	Disabling EUP compliance mode

	Accessibility
	Hyper-threading
	Intel Turbo Boost Technology
	HP Cool Tools
	Ensuring proper ventilation


	Setting up the operating system
	Setting up the Microsoft operating system
	Installing or upgrading device drivers
	Transferring files and settings to your Windows workstation

	Setting up Red Hat Enterprise Linux
	Installing with the HP driver CD
	Installing and customizing Red Hat-enabled workstations
	Verifying hardware compatibility


	Setting up Novell SLED
	Updating the workstation
	Updating the workstation after first boot
	Upgrading the BIOS
	Determining current BIOS
	Upgrading BIOS

	Upgrading device drivers


	Restoring the operating system
	Restore methods
	Ordering backup software
	Restoring Windows Vista
	Ordering the RestorePlus! media
	Restoring the operating system

	Restoring Windows XP Professional
	Creating RestorePlus! media
	Creating HP Backup and Recovery (HPBR) media
	Restoring the operating system
	Using RestorePlus!
	Using HPBR
	Using the recovery partition


	Restoring Novell SLED
	Creating restore media


	System management
	BIOS ROM
	The Computer Setup (F10) Utility
	Computer Setup (F10) functionality
	Accessing the Computer Setup (F10) Utility
	The Computer Setup (F10) Utility menu

	Workstation management
	Initial workstation configuration and deployment
	Installing a remote system
	Replicating the setup
	Copying a setup configuration to a single workstation
	Copying a setup configuration to multiple workstations

	Updating and managing software
	HP Client Manager Software
	Altiris Client Management Solutions
	System Software Manager
	Proactive Change Notification
	Subscriber's Choice
	ROM Flash
	Remote ROM Flash
	HPQFlash

	FailSafe Boot Block ROM
	Recovering the workstation from Boot Block Recovery mode

	Workstation security
	Asset tracking
	SATA hard disk drive security
	DriveLock applications
	Using DriveLock
	Enabling DriveLock


	Password security
	Establishing a setup password using Computer Setup (F10) Utility
	Establishing a power-on password using workstation setup
	Entering a power-on password
	Entering a setup password
	Changing a power-on or setup password
	Deleting a power-on or setup password
	National keyboard delimiter characters
	Clearing passwords

	Chassis security
	Side access panel sensor (Smart Cover Sensor) (optional)
	Setting the side access panel sensor protection level

	Side access panel solenoid lock
	Cable lock (optional)


	Fault notification and recovery
	Drive Protection System
	ECC fault prediction
	Thermal sensors

	Dual-state power button
	Changing the power button configuration



	Replacing components
	Warnings and cautions
	Service considerations
	Cautions, warnings and safety precautions
	ESD information
	Generating static
	Preventing ESD equipment damage
	Personal grounding methods and equipment

	Grounding the work area
	Recommended ESD prevention materials and equipment
	Tools and software requirements
	Special handling of components
	Cables and connectors
	Hard disk drives
	Lithium coin cell battery


	Customer self-repair
	Removing and installing components
	Component locations
	Predisassembly procedures
	Disassembly order
	Cable lock (optional)
	Side access panel
	Removing the side access panel
	Installing the side access panel

	Side access panel sensor (optional)
	Removing the side access panel sensor
	Installing the side access panel sensor

	Side access panel solenoid lock
	Removing the side access panel solenoid lock
	Installing the side access panel solenoid lock

	Bezel
	Removing the front bezel
	Installing the front bezel

	Front panel I/O device assembly
	Removing the front panel I/O device assembly
	Installing the front panel I/O device assembly

	Power button assembly
	Removing the power button assembly
	Installing the power button assembly

	Optical disk drive
	Removing an optical disk drive from the optical bay
	Installing an optical disk drive in the optical bay

	Workstation speaker
	Removing the workstation speaker
	Installing the workstation speaker

	Power supply
	Removing the power supply
	Installing the power supply

	Power connections
	Rear system fan assembly
	Removing the rear system fan assembly
	Installing the rear system fan assembly

	Memory
	DIMM installation guidelines
	DIMM installation order
	Supported DIMM configurations
	BIOS errors and warnings
	Removing a DIMM
	Installing a DIMM

	Expansion card slot identification
	Slot identification and description
	Card configuration restrictions for power supplies
	Choosing an expansion card slot

	Expansion card
	Expansion card slot description
	Removing an expansion card
	Installing an expansion card

	Battery
	Removing the battery
	Installing the battery

	Hard disk drive
	Removing the hard disk drive
	Installing the hard disk drive
	Installation guidelines
	Installation


	CPU heatsink
	Removing the CPU heatsink
	Installing the CPU heatsink

	CPU
	Removing a CPU
	Installing a CPU

	System board
	Removing the system board
	Installing the system board


	Product recycling

	Diagnostics and troubleshooting
	Calling technical support
	Locating ID labels
	Locating warranty information
	Diagnosis guidelines
	Diagnosis at startup
	Diagnosis during operation

	Troubleshooting checklist
	HP troubleshooting resources and tools
	HP Help and Support Center
	E-support
	Troubleshooting a problem
	Instant Support and Active Chat
	Customer Advisories, Customer and Security Bulletins, and Customer Notices
	Product Change Notifications

	Helpful hints
	At startup
	During operation
	Customizing the monitor display


	Troubleshooting scenarios and solutions
	Solving minor problems
	Solving power supply problems
	Testing power supply

	Solving diskette problems
	Solving hard drive problems
	Solving display problems
	Solving audio problems
	Solving printer problems

	Self-troubleshooting with HP Vision Field Diagnostics
	Overview
	Downloading and accessing HP Vision Field Diagnostics
	User interface
	Survey tab
	Test tab
	Status tab
	History tab
	Errors tab
	Help tab

	Saving and printing information in HP Vision Field Diagnostics
	Downloading the latest diagnostic utility

	Diagnostic codes and errors
	Diagnostic LED and audible (beep) codes
	LED color definitions
	POST error messages


	Configuring RAID devices
	Maximum hard drive configurations
	Configuring SATA RAID devices
	Attaching SATA HDDs
	Configuring system BIOS
	Creating RAID volumes
	Deleting RAID volumes

	Configuring SAS RAID devices
	Supported configurations
	SAS RAID 0 configuration
	SAS RAID 1 configuration
	SAS RAID 1E configuration


	Configuring password security and resetting CMOS
	Preparing to configure passwords
	Resetting the password jumper
	Clearing and Resetting the CMOS
	Using the CMOS Button
	Using the Computer Setup (F10) Utility to Reset CMOS


	Connector pins
	System board designators
	Routine Care
	General cleaning safety precautions
	Cleaning the workstation case
	Cleaning the keyboard
	Cleaning the monitor
	Cleaning the mouse

	Locating HP resources
	Product information
	Product support
	Product documentation
	Product diagnostics
	Product updates

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.7
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Remove
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /Courier-Oblique
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Oblique
    /Symbol
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /ZapfDingbats
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.00000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.00000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.33333
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /SyntheticBoldness 1.000000
  /Description <<
    /ENU <FEFF0046004f00520020004100630072006f00620061007400200038000d0048005000490045002000530063007200650065006e0020004f007000740069006d0069007a00650064002000530065007400740069006e006700200066006f00720020004100630072006f00620061007400200038>
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


